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Databazové systémy

Uz vieme, ze pocitac nie je stroj na pocitanie (alebo len na pocitanie). Povedali sme si, ze ide
o stroj, ktory slizi najmd na spracuvanie informécii. Pod slovom spracuvanie sa skryva
evidovanie (zaznamenavanie, uchovavanie), selektovanie (vyber vhodnych tdajov) a vystup
(najcCastejsie na tlaciarenl) udajov.

V pocitacovej oblasti je na takuto pracu urcena zvlastna skupina programov, ktorym sa hovori
databazové systémy. Sluzia prave na uchovavanie a spraciivanie informdcii. Informécie st
uchovavané v zoznamoch (mozno si ho v jednoduchom pripade predstavit’ ako jeden subor) -
databazach.

Jednoduchym prikladom databazy je napr. telefénny zoznam. Obsahuje udaje o mene, adrese
a telefébnnom c¢isle. V pripade, ze hl'adame telefonne Cislo konkrétnej osoby, nalistujeme jej
meno v abecednom zozname a jednoducho zistime telefonne Cislo.

Horsie je, ked’ pozndme len adresu niektorého zo svojich obchodnych partnerov, ale zabudli
sme jeho meno (pripadne sme si ho zapisali absolutne necitatel'ne). Kym by sme v zozname
nasli prislusnti adresu, potrebovali by sme pozorne(!) prejst’ z neho zna¢nt Cast’ (ak by sme
skor nezosediveli). A prave tu sa ukaze sila databdzového systému a rychlost’ spracovania
informadcii (ndjdenie vSetkych osob evidovanych na uvedenej adrese).

Zvolime si hl'adanie podl'a adresy, zadame adresu a skor nez sa statime nadychnut’, vysledok
mame pred sebou. V horSom pripade ddme len usporiadat’ udaje nie podla mena (ako
v klasickom papierovom zozname), ale podl'a adresy a hl'adanie je opét’ vel'mi jednoduché.
Dal§im prikladom moZze byt &asto spominanad kniZnica. V beZnej (starym spdsobom
mysliacej) kniznici su tri katalégy - podl'a autorov, podl'a ndzvu a systémovy podla oblasti.
Zbyto¢ne vela regalov a zbytocne vela papiera. Kazda kniha je totiz evidovand trikrat -
v kazdom katalégu raz. A ak sa ndhodou stane, ze nedisciplinovany Citatel poprehadzuje
kartote¢né listky, pravdepodobnost’ ndjdenia hl'adanej publikacie poriadne klesne. Ak ma
kniznica k dispozicii pocitac, operatorka (postaci osoba, ktora rozozna pismena na kldvesnici)
naplni databazu tdajmi (o kazdej knihe len raz) a to je vsetko. Pocita¢ (resp. databazovy
systétm) udaje usporiada podla zelania, vyhladd pozadované knihy, pripadne knihy
obsahujtce zvolené kl'icové slova a konecny vystup mdze i vytlacit. Ak sa kniznica nebrani
vyuzitiu pocitaca plne, eviduje v iom aj Citatel'ov, vypozi¢ky a upomienky. V kniznici, ktora
ma na starosti pocitac, nemusi knihovnic¢ka kazdé rano prezerat' zoznam vypozi€iek a hl'adat’
darebdkov, ktorym treba poslat’ upomienku. Ak ma pouzivany systém zabudovanu ¢o len
trosku inteligencie, po spusteni programu automaticky vyhlada ¢itatel'ov, ktori k aktudlnemu
datumu mali knihy vratit, vytla¢i im upomienky a jedinou starostou knihovnic¢ky je zaniest’
ich na postu. (Je pravdepodobné, Ze vo velmi blizkej buducnosti - technickd realizacia je
mozna uz v sucasnosti, no krachuje kvoli neschopnosti I'udi a strachu z pouzivania
¢ohokol'vek nového - bude uz upomienky posielat’ po sieti samotny pocitac.)

V obchodnych domoch a vel'koskladoch uz prisli na to, Ze bez pocitata sa mozno zaobist’ len
vel'mi tazko. V oblastiach, kde je nutné rychlo a pruzne reagovat’ na poziadavky zakaznika,
Clovek nestiha. Nie je mozné, aby si v hlave udrzal informacie o cenach, kvalite a mnozstve
tovaru. Vd’aka pocitaom netreba - ma k dispozicii databazu (ktora potrebné udaje obsahuje)
a databazovy systém (ktory s nimi dokaze pracovat).

Praca s databazovym systémom nie je zlozitad. Bezné operacie mozno zhrnut' do niekol’kych
oblasti:

- vkladanie udajov a prezeranie databazy,

- tpravy (napr. mazanie),

- triedenie - usporiadanie podl'a abecedy, podla ¢iselnych hodndt ap.,
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- vyber, prehl'adavanie (napr. iidajov spinajticich zadant podmienku - zvolena adresa...),
- matematické a Statistické operacie (sucty, priemery, ...),
- vystupy (napr. na tlaciaren).

V praxi nezélezi na tom, s akym systémom pracujeme, ide len o to, aby sme mali pristup
k informaciam. NajdolezitejSie su pre nds udaje, nie spdsob (program - databazovy systém),
akym sa k nim dostaneme.

Existuje mnoho databazovych systémov, ktoré st schopné vykonavat vsSetky spomenuté
operacie. Medzi najznamejSie a najpouzivanejSie v nasich podmienkach patria dBase, FoxPro,
Paradox a v sti¢asnosti sa presadzuje Access pracujuci pod Windows.

V beznej praxi sa vSak nestretnete s databdzovym systémom v jeho povodnej - surovej
podobe. V kazdom zo spominanych systémov totiz mozno vytvarat’ aj aplikacie - programy,
ktoré st uz prisposobené konkrétnym oblastiam pouzitia. Ul'ahcuju a zrychluju pracu, davaja
k dispozicii len operacie, ktoré ta-ktora oblast’ vyuzitia potrebuje.

Na Slovensku (v ekonomike a beznej praxi) je najCastejSie pouzivanym systémom prave
FoxPro.

Naucit’ sa pracovat’ s jednym systémom znamenda zvladnut’ temer vSetky, pretoze odliSnosti
prace s nimi st naozaj len minimalne.

Databazovy systém FoxPro

Po spusteni FoxPro sa dostaneme do zakladného prostredia systému. Hlavnou a prvou ulohou,
ktora pre pracu so systémom potrebujeme, je vytvorit’ zoznam - databazu, do ktorej sa budu
vkladat’ udaje.

System File Edit Database Record Program Window

— ——
- —-— - -
- m - -
- - -
- —-— I EE——— - - - — —-—
— - - - - —— - . - - -
- - - - = - —-— - -
- - - —-— - - - -
- - - - . - - - -
- - - - - - - - -
— —-— ] — —-—
FoxPro 2.8

(c) Fox Holdings 1989-91, Pat.Pend.
European Edition

Vytvorte zoznam svojich znamych. Mal by obsahovat ich meno, adresu, vek a zamestnanie.

Databazu (zoznam) si moZno predstavit' ako tabulku, v ktorej budi ulozené udaje (vasi
znami). Tabulka bude rozdelena na stlpce a riadky. Kazdy stlpec bude zodpovedat’ jednému
udaju a kazdy riadok bude obsahovat tdaje o jednej osobe:

MENO ADRESA VEK ZAMESTNANIE
Jozo Dolna 54 33 robotnik

Fero Mokrovce 11 78 dochodca

Beata Staré Novce 155 12 ziak

Dezo Mrkvic¢kovo 999 19 nezamestnany
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Pohybovat sa a ovladat FoxPro mozno okrem klavesnice aj mySou. Pri praci
s klavesnicou sa po jednotlivych polozkach pohybujeme klavesmi TAB alebo Shift+TAB
(pripadne Sipkami); ak pouzivame mys, staci sa na polozku nastavit’ a stlacit’ l'avé tlacidlo.
Menu sa vyvolava stlacenim F10 alebo Alt (pripadne Alt + zvyrazneny znak).

Vytvorenie databazy

New. ..
Open. .. Ak chceme vytvarat novil, neexistujicu databazu, potrebujeme najprv
Save ur¢it’, z ¢oho sa bude skladat’, aké idaje bude obsahovat’ - potrebujeme
Save as... pomenovat’ stipce, vytvorit’ akusi hlavi¢ku - §truktiru zoznamu.
Najprv zvolime File> New.
Printer Setup... , v .
Print. .. Pontiknu sa moznosti:
Quit
Vyberte Database (ideme vytvarat zoznam - databazu) a New:
odsuhlaste OK. Po tejto akcii sa spusti dialog, v ktorom treba 03 Datemace
urcit’ jej Strukturu. ( ) Program
Struktara databazy hovori nielen o tom, ako sa budu (> Index « 0Kk »
jednotlivé stipce volat, ale aj o type Gdajov a ich $irke - ¢ ) epont < Cancel >
kolko znakov sa ma do nich vojst’. ¢ ) poreen
Name - meno (nazov) stipca (v naom pripade mozeme prvy <3 g:z;gc .
stlpec nazvat MENO). NapiSeme meno a tabelatorom (alebo

mysSou) preskoc¢ime do d’alSieho okna.

Type - hovori o typ,e udajov (text, Cislo, datl,lm...), Stroctire: Dtitica
ktoré bude stlpec obsahovat’. (Ak Type  Width Dec
+Character A . ro. ., Field
Numeric uvedieme, ze v stlpci budu Cisla, Character 28
Ploat po¢ita¢ nedovoli pri napliani Character 18 <Insert>
ﬂtE 7 . . ’ 9 v I3
Logical udajmi pisat’ bezné znaky - bude delete>
Memo r )
Picture len bezradne pipat’.)
Pre bezny text (pismend + ¢isla + « 0K »
Specialne znaky) sa pouziva Character. Pre nas <Cancel>
stlpec teda vyhovuje. Fields: 2 Length: 31 fvailable: 3969

Ak chceme zvolit’ iny typ, staci stla¢it ENTER a
vybrat’ si z ponuky.

Width - $irka stipca = maximélny pocet znakov, ktoré moéze udaj v stipci obsahovat’. Pre nase
momentalne potreby postaci 20. Na policko sa sta¢i nastavit' a pisat. Pokial je vysvietené
namodro, povodny text sa automaticky zmaze, inak sa bude postvat. Maximalna povolena
Sirka je 254 znakov.

Po MENE rovnakym spdsobom zaddme ADRESU. Typ ani §irka sa nemenia.

Polozka VEK, ktorej udaje vlozime do treticho riadku, uz nebude znakového typu. Bude
naplnend ¢islami. FoxPro pontka dva ciselné typy. (Nastavte sa na Type a stlacte ENTER).
Prvym, castejSie pouzivanym, je Numeric, druhym Float uréeny pre nepresné Cisla.
Nastavime Numeric. Pre Sirku pola postacia 3 miesta, t.j. 0 - 999 rokov.

Po zmene typu na &iselny (Numeric, Float) sa aktivuje aj §tvrty stipec - Dec - podet
desatinnych miest. V tomto pripade ponechame 0.

Pri vytvérani $truktary este nenapliiame databazu, len zadavame, z ¢oho sa bude skladat’.

Udaje o poslednom stipci mézu byt rovnaké ako o prvych dvoch.
Nézov stlpca nemusime pisat’ vel'kymi pismenami, menia sa automaticky.
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Structure: Untitled
Name Type Width Dec
Field
ks Character 28
ks Character 38 <Insert>
ks Numeric 3 a
ks Character 15 <Delete>
« Q0K »
<Cancel>
Fields: 4 Length: 64 Available: 3936

Typ stipca sme nemenili zo znakového na &iselny kvoli zobrazovaniu, pretoze aj do stipca,
ktory je typu Character, mdzeme pisat’ &isla. Stipec sa stal ¢iselnym kvoli operaciam. Zo
znakovych udajov nemozno urobit’ sucet, priemer, ani ich logicky usporiadat’ (1, 2, 3, 10, 15,
24 - pre Cisla by sa pre znaky usporiadalo ako 1, 10, 15, 2, 24, 3 - podl'a "abecedy").

Po naplneni a skontrolovani Struktary mo6zeme udaje potvrdit’ - OK.
Reakciou bude ziadost’ o zadanie mena databazy:

Name the new database:

FOXHELP .DBF
FOXUSER.DBF

ARCH . DBF

G.DBF Directory |FOXPROZB
KNIHY.DBF

« Save »
[ 1 All Files < Cancel >

l I

Do spodného riadku napiSeme meno suboru, do ktor¢ho budeme udaje vkladat, a po
odklepnuti Save sa na disk zapiSe jeho Struktara.
Potom dostanete otazka, ¢i vkladat’ iidaje teraz alebo az neskor.

Input data records now?

<« Yes » < No >

V pripade, ze zvolite No, dostanete sa do povodného stavu, v pripade Yes, dostanete
k dispozicii prazdnu tabul’ku, obsahujucu nazvy stlpcov, do ktorych mézete vkladat’ udaje. Pri
vlozeni prvej polozky sa automaticky vytvori d’alSia sada.

] ZNAMI
Meno Dezidor Novak
Adresa Hrnovce 55
Vek 32
Zamestnani krcmar

* >l

Meno Mi

Adresa ;. ,

Uek naplnand a ... '
Zamestnani

»Meno
»Adresa

»Uek ... automaticky vytvorend sada
»Zamestnani

Ked’ do zoznamu vlozime vsetky tidaje, mézeme skoncit. Okno s databazou najjednoduchsie
zrusime stlacenim ESC alebo rozumne;jSie Ctr/+W.
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Ak stlacime ESC na polozke, do ktorej sme prave viozili udaj, prideme on. Program si totiz
nase ESC vysvetli ako snahu o zruSenie zmien v aktudlnej polozke. (Podobne to bolo v T602
pri obnoveni riadku - ak sme urobili zmeny, zostali na riadku a chceli sa vratit' k povodnému
obsahu, Slo to; ak sme sa posunuli na iny riadok, navrat bol nemozny.)

Ak teda chceme koncit pracu stlacenim ESC, treba sa predtym presunut napr. o riadok spdt.

FoxPro potom opustime vol'bou File-> Quit.

Vo FoxPro netreba nahrdvat sibor na disk. Udaje sa ukladajii automaticky - hned’ pri
vkladani.

Nevypinajte pocitac, kym neopustite FoxPro. Mohlo by sa stat, Ze pridete o subory,
s ktorymi ste pracovali. Ak chcete pocitac¢ vypnut, zvolte najprv File>Quit, ¢im jednak
odloZite a zatvorite vSetky pouzivané subory, jednak opustite FoxPro a vratite sa do
Startovacieho prostredia.

Praca s existujucou databazou

Otvorenie

Open:

ARCH . DBF
FOXHELP .DBF

FOXUSER.DBF
G.DBF Directory |FOXPROZB
KNIHY.DBF

ZNAMI . DBF

<« Open »

[ 1 All Files < New >

Datahase Type < Cancel >

Spustime opét’ FoxPro a zvolenim File->Open v hlavnom menu sa pokiisme otvorit’ databazu
s udajmi o svojich znamych.

Vybrali sme meno suboru, zvolili Open - a ni¢. Udaje, ktoré sme do databazy vlozili, sa
nezobrazili. St stratené?

Otvorenie databazy eSte neznamena jej zobrazenie. Postupnost'ou File->Open len otvorime,
pripravime tidaje na d’alSie spracuvanie.

Ak chceme udaje aj zobrazit, vyberieme Record->Append. Zobrazi sa naplnend databdza a
mdzeme pokracovat’ napr. priddivanim d’alSich poloziek.

Rezimy zobrazenia

Vo FoxPro mozno s databazou pracovat v dvoch zobrazeniach - vtom, aké sme mali
doposial’ - riadkovom (hovori sa mu append alebo change) - alebo v tabul’kovom (browse -
stipcové).

Mozno sa medzi nimi 'ubovol'ne prepinat’ a zalezi len od uzivatel’a, s ktorym bude pracovat’.
Do rezimu browse sa z rezimu append dostaneme zvolenim Browse=> Browse.

Nazad tym istym spdsobom, ale namiesto polozky Browse najdeme v menu Append alebo
Change.
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REZIM APPEND
System File Edit Database Record Program UWindow Browse
1 ZNAMI I
Meno Michal Drak Browse
Adresa Brnovce 44 Grid Off
Vek 25 Unlink Partitions
Zamestnani starosta Change Partition “H
Meno Juraj Maly Size Field
Adresa Antily 226 Move Field
Vek 54 Resize Partitions
Zamestnani farmar
Goto. ..
Meno Ivan Tretuch Seek. ..
Adresa Horny Dolnik 12 Toggle Delete “T
Vek 43 Append Record “N

Zamestnani ucitel

REZIM BROWSE
System File Edit Database BRecord Program UWindow Brouwse
N ZNANMI
Meno Adresa Uek|Zamestnani| Append
Grid Off
Dezidor Novak Hrnovce 55 32| krcmar Unlink Partitions
Michal Drak Brnovce 44 25|starosta Change Partition “H
Juraj Maly fAntily 226 54|farmar
Ivan Tretuch Horny Dolnik 12 43 |ucitel Size Field
» Move Field
Resize Partitions
Goto...
Seek...
Toggle Delete “T
Append Record “N

Nazvoslovie

Kvoli lepsej zrozumitelnosti sa (aj v databazovych systémoch) zaviedlo jednotné nazvoslovie.

Celému suboru udajov mozno hovorit’ databaza alebo tabul'ka (database, table).

Jeden riadok tabulky sa nazyva zaznam alebo veta (record).
Stlpcu tabul’ky patri pomenovanie pole (field).

Meno Dezidor Novak
Adresa Hrnovce 55
Vek 32

Zamestnani krcmar

Meno Adresa Vek |Zamestnani
Dezidor Novak|Hrnovce 55 32 | krcmar
Michal Drak Brnovce 44 25 |starosta

Vytvorte databazy:
AUTOBAZAR s polami:
ZnackaCH 15

Cena N 6
Vek N 2
Najazdene N 10
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KRAJE s polami:

Kr _mesto CH 25
Okresov N 2
Obyvatelov N 6
Zameranie  CH 15

Pod zameranie uvedte napr. polnohospodarstvo, strojarstvo, banictvo, obchod...

Zmena Struktury databazy

Vytvorte databazu TOVAR s polami:

Nazov CH 20
Kusov N 5
Cena N 5
Dodavatel CH 20

a naplnte ju.

Databaza je naplnend, st v nej vSetky druhy tovaru, ale ma jednu chybu: ceny su v celych

korunach...
Databhase: C:\FOXPROZB\TOVAR.DBF
Structure: <Modify> Indexes: Index
MNAZOV c 20 a
Kusou N 5 a < Add... >
CENA N 5 a
DODAVATEL c 20 a <Modify...>
< Remove >
<No Order >
Fields: 4 Length: 51 Index expr:
Index filter:
[X]1 Set Fields...
C ) On (.) Off « 0K »
[ 1 Filter...
[ 1 Format...

Na to, aby sme tento nerealny stav zmenili, nepotrebujeme vytvorit’ novy subor, v ktorom by
sme pre stipec s cenou nastavili dve desatinné miesta, ale stadi nam zmenit' $truktiru
vytvorenej databazy - zmenit' $irku stipca a pridat’ dofi dve desatinné miesta. PouZijeme
Database-> Setup, kde pre naSe potreby zatial’ postaci vol'ba Modify.

Structure: C:\FOXPROZB\TOVAR.DBF
Name Type Width Dec
Field
ks AZOV Character 28
ks usov Numeric 5 a <Insert>
ks ENA Numeric 5 a
ks ODAVATEL Character 28 <Delete>
« Q0K »
<Cancel>
Fields: 4 Length: 51 Available: 3949
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Dostali sme sa do rovnakého okna, v akom sme sa nachadzali pri vytvarani novej databazy.
Dalsie polia méZeme na koniec pridavat’ bez akychkol'vek obmedzeni. Ak chceme vloZit' pole
medzi uz existujuice, nastavime sa na riadok, pred ktory ho chceme pridat, a zvolime Insert
(bud’ priamo v okne - ak mame mys - alebo cez menu Structure->Insert Field).

Ak chceme pole vymazat’, pouzijeme Delete.

Nasou ulohou je v§ak zmenit’ cenu tak, aby zodpovedala beznému pouzivaniu, t.j. pridat’ dve
desatinné miesta.
Nastavime sa na Dec a jednoducho dopiSeme 2.

Cena Numeric 5 2

Co sa tym stalo?

FoxPro zur¢itych doévodov (znamych len programatorom, ktory ju vytvorili) nereaguje na
takato zmenu beznym sposobom, t.j. nevyhradi si pre cenu 5 miest + 2 desatinné, ale:

- na celé Cislo (celd Cast’, bodka, desatinna ¢ast’) vyhradi 5 miest;

- z tych piatich odtrhne zadané dve na desatinnu Cast’;

- a jedno na desatinna bodku.

- a jedno na desatinna bodku.

Uvedenym nastavenim ziskame dvojciferné ¢islo s dvoma desatinnymi miestami. Zadana
Sirka pol'a hovori nie o pocte cifier celoc¢iselnej Casti, ale o celkovom pocte miest, do ktorého
sa musi vojst’ ¢islo aj s desatinnymi miestami.

Ak vnaSom pripade chceme, aby cena mala 5 celych miest a 2 desatinné, potrebujeme
vyhradit’ Sirku 8 (5+2+des. bodka).

V pripade, ak zvolime No, vratime sa spdt do Modify. Ak by sme chceli zrusit zmeny, ktoré
sme v Strukture urobili, cesta vedie cez Cancel.
Po odklepnuti Cancel dostaneme otazku, ¢i chceme zrusit zmeny.
Ak na tuto odpovieme Yes, vratime sa k povodnej Strukture databazy.

Make structure changes permanent?

<« Yes » < No >

Po zmenach Struktiry odsuhlasime OK a na otdzku, ¢i ich zachovat’ natrvalo, odpovieme Yes.
Zmeny, ktoré sa vykonaju v databaze, nemaju desStruktivny vplyv na udaje v nej obsiahnuté.
Vsetky udaje zostani zachované (okrem zvlaStnych pripadov, ktoré eSte spomenieme) a
v pripade, Ze sa zmeni typ pol'a (napr. z Numeric na Character), zmenia aj svoj typ.

Pridajte k databdze dalsie dve polia - Cena s _dph a Clo.

Vyber poli (projekcia)

Casto sa stava, ze databaza obsahuje viac stipcov, ako momentalne potrebujeme. Niektoré
prekédzaju a zbyto¢ne zaberaju miesto na monitore. Vtedy je najjednoduchsie skryt’ ich (resp.
vybrat’ na zobrazenie len potrebné stipce).

Tato operaciu umoznuje kazdy databazovy systém a ani FoxPro nie je vynimkou.
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Otvorte databdzu TOVAR z predchadzajucej ulohy a nechajte zobrazit' len ndzov tovaru a
Jjeho cenu.

Otvorit’ databazu vieme. Nezavisle na tom, ¢i je zobrazena alebo nie, staci zvolit
Database-> Setup a vybrat’ polozku Set Fields (nastav polia).

Datahase: C:\FOXPROZB\TOVAR.DBF

Structure: <Modify> Indexes: Index
Datahase Fields: Selected Fields:
< Add... >

NAZOV c 20 a < Move » > R
Kusov N 5 1] <Modify...>
CENA N 8 2 < All » >
DODAVATEL c 20 a < Remove >
CENA_S_DPH N 8 2
CLO N 8 2 < Remove > <No Order >

<Remove All>

Database:

TOVAR « 0K ” « OK »

< Cancel >

Ziskame okno rozdelené na dve Casti. V prvej je zoznam vSetkych poli, druhd je prazdna.
Lava Cast’ obsahuje zoznam vSetkych poli, pravé len tie polia, ktoré sa maju zobrazovat’. Ak je
prava polovica prazdna, znamena to, Ze sa budll zobrazovat' vSetky polia (ziadne nie st
vybraté).

Ak chceme zobrazit’ konkrétne polia, treba ich z l'avej Casti preniest’ do pravej. Existuje na to
zasa niekol'’ko moZnosti:

- na pozadované pole dva razy klikneme mySou,

- nastavime sa na pozadované pole a ENTERom ho presunieme,

- nastavime kurzor na pozadované pole a klikneme Move...

Ak chceme preniest’ vSetky polia, zvolime A//; ak chceme zrusSit’ zobrazenie pol’a, prenesieme
ho analogickym sposobom z pravej Casti do l'ave;.

Po spravnom vybere a odsuhlaseni sa vratime opit do okna Setup. Vybrané polia svietia
normalne, nevybrané su pohasnuté.

Po d’alSom odsuhlaseni a znovuzobrazeni databazy méme skuto¢ne k dispozicii len udaje zo
zvolenych poli.

V pripade, Ze mate zobrazené nielen vybrané polia, zruste okno s databazou a dajte opdt
Append alebo Browse. Tento nedostatok sa pomerne casto objavuje aj pri dalSich
cinnostiach, no da sa nan zvyknut.

Vratte zobrazenie databazy do povodného stavu (t.j. zobrazte vSetky polia).
Zobrazte len nazov tovaru a pocet kusov na sklade.

Zobrazte nazov tovaru, dovozcu a clo.

Zobrazte databazu tak, aby nebola viditelna cena s DPH.
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Vyber riadkov (filtracia)

Podobne, ako nie vzdy potrebujeme zobrazit’ vietky stipce, sa stava, Ze chceme z databazy
vybrat’ len niektoré vety - riadky. Vyber riadkov podl'a podmienky (zaddvame ju my) sa
nazyva filtracia (udaje filtrujeme - cez sito prejdu len tie, ktoré splnia uréenti podmienku).
FoxPro takmer pri vSetkych funkcidch umoznuje pouzivat’ filter, no najjednoduchsi spdsob
vyberu dosiahneme pouzitim Database > Setup a v otvorenom okne zvolime Filter.

Vyberte z databazy TOVAR len tovar, ktorého cena je vicsia ako 50,- Sk.

| Math " | String " | Logical " | Date "
- SET FILTER Expression: <expL>
Field Names: Databhase: Variables:
L |
MNAZOV c | TOUAR “ »_ALIGNMENT C a
Kusou N _BoX L e
CENA N _INDENT N
DODAVATEL c < Verify > _LMARGIN N
CENA_S_DPH N _PADUANCE c
cLO N « 0K » _PAGENO N
_PBPAGE N
< Cancel > _PCOLNO N~
]

Zadanu ulohu potrebujeme najprv pochopit. O ¢o ide?

Chceme, aby sa zobrazili len tie riadky, ktoré maji v polozke Cena Cislo vacsie ako 50.
Podmienka teda bude Cena > 50. Zadat ju moZno opit niekol’kymi sposobmi, no
najjednoduchsi je:

1. dva razy kliknit mySou do okna Field names na riadok s cenou, ¢im do okna Set filter
prenesieme Uplny nazov pola (tovar.cena),

2. dopisat’ za cenu zvySok podmienky: >50,

SET FILTER Expression: <expL>
tovar.cena>58

3. odsuhlasit’ OK.

Pokial’ si nie sme celkom isti, ¢i nasu podmienku pocitac pochopi, mozZeme si jej spravnost
overit volbou Verify. Ak je vsetko v poriadku, vypise: Expression is valid.

Po navrate do okna Setup vidime text podmienky pri Filtri.

Database: C:\FOXPROZB\TOVAR.DBF

Structure: <Modify> Indexes: Index
|
M [»NaZzov C 20 B
y Kusov N 5 [t} < Add... >
y CENA N 8 2
) DODAVATEL C 28 2} <Modify...>
) CENA_S_DPH | N 8 2
) CLO N 8 2 < Remove >
|
y <No Order >
|
|

Fields: 6 Length: 78 Index expr:

Index filter:
[ 1 Set Fields...
() On C(+) Off . . « 0K »
[X1 Filter... tovar.cena>sd riadok s podmienkou
[ 1 Format...

V databaze zostali zobrazené len riadky spifajiice podmienku (ak sa v nej vyskytuju iné
riadky, zruste ju a opat’ zobrazte).
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Filter zruS§ime opdtovnym navratom a vymazanim podmienky.

Vyberte tovar, ktorého je na sklade menej ako 20 kusov.

Vyberte tovar, ktorého clo je 200,- Sk.
(podmienka: tovar.clo = 200)

Vyberte tovar, ktorého cena s DPH je 100,- Sk a viac.
(podmienka: tovar.cena_s_dph>99 alebo tovar.cena_s_dph>=100).

V databazach mozno, samozrejme, pouzivat' projekciu a filtraciu (vyber stipcov a vyber
riadkov) aj sucasne. Vtedy sa udaje vyberaju podl'a podmienky a zobrazia sa len nastavené
stlpce.

Pole (stlpec), ktoré je pouzité v podmienke, musi byt zobrazené.
V podmienke nesta¢i uviest’ len nazov stipca, je potrebné pridat’ aj nazov databazy a oddelit
ich bodkou: napr. tovar.cena. Pisanie moZzeme uSetrit’ klepnutim mysi na prislusné pole

v okne Field names.
V pripade, Ze podmienke nevyhovuje ani jeden riadok, zobrazi sa prazdna databaza.

Vytvorte databdzu ziakov triedy, v ktorej budete evidovat: meno, vek, priemer zndmok,
znamku za sprdavanie, dochdadzku (miestny, cezpolny), pocet vymeskanych hodin a pocet
surodencov.

Zobrazte meno, priemer a znamku za spravanie.

Zobrazte meno, dochadzku a pocet vymeskanych hodin.

Zobrazte meno, znamku za spravania a pocet vymeSkanych hodin.

Zobrazte len ziakov, ktori maju dvoch surodencov.

Zobrazte Ziakov, ktori nemali zo spravanie jednotku.

Zobrazte vyznamenanych (priemer znamok je 1,5 a menej).

Zobrazte cezpolnych.

Tu sa trochu zastavime. Pri beznych podmienkach (kym sme pracovali s polami ¢iselného
typu) sme podmienku napisali ako nazov pola, znamienko a ¢islo.

Pri znakovych (Character) poliach potrebujeme hodnotu (obsah, s ktorym pole porovnavame)
uzavriet’ do oddel'ovacov (v pripade znakovych hodnét su to ivodzovky).

Podmienka teda nebude vyzerat’ dochadzka = cezpolny, ale

dochadzka = “cezpolny”

Tento “nedostatok” ma svoje opodstatnenie, no zaoberat’ sa nim nie je nasim ciel'om.
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Zobrazte cezpolnych Ziakov tak, aby sme videli len ich mena a dochadzku. (Nastavime filter
na dochadzka = “cezpolny” a vyberieme polia meno, dochadzka).

Zobrazte Ziakov s priemerom do 2,0 s tym, Ze nds zaujima ich meno, priemer, zndmka zo
spravania a pocet vymesSkanych hodin.

Zobrazte ziakov, ktori maju viac ako troch surodencov, a vyberte polia: meno, priemer, pocet
surodencov.

Viachasobné podmienky

Vyberte zZiakov, ktori su cezpolni a maju jedného surodenca.

Tato tloha nie je rovnakého typu, ako st predoslé, hoci tak na prvy pohl'ad vyzera.
St v nej skryté dve podmienky:

1. ziaci maju byt’ cezpolni (dochadzka = “cezpolny”),

2. maju mat’ jedného surodenca (poc_surod = 1).

Kazdu z Casti Glohy dokazeme vyriesit, no ich spojenie, t.j. aby platila aj jedna, aj druha
podmienka, vyzaduje Cosi viac.

Cosi viac je spojka "a sudasne" (and).

Treba ju vlozit medzi podmienky vo filtri.

Hovori pocitacu, aby vyberal tie riadky, v ktorych platia obe podmienky sucasne. Slovicku
and sa hovori logicka spojka a od ostatného textu by malo byt oddelené bodkami.

Spravne bude podmienka vyzerat’ ako:

| Math “ | String " | Logical " | Date "

r SET FILTER Expression: <{expL>
ziaci.dochadzka="cezpolny".and. ziaci.poc_surod=1

I

Field Names: Database: Variables:

| ZIACI “ »_ALIGNMENT
BOX

INDENT

MENO

VEK

PRIEMER

SPRAVANIE

UYM_HODINY

DOCHADZKA
»POC_SUROD

LMARGIN

< Verify > :
_PADVANCE

ZOZXTITITIO

« oK » PAGENO

PBPAGE

ZZTIOHZTICO
-4 I ¢ > B

PCOLNO
—— |

< Cancel >

Vyberte Ziakov, ktori maju viac ako 2 surodencov a su vyznamenani (t.j. priemer je do 1,5).

Vyberte Ziakov, ktorych priemer je nad 2,5, alebo maju zo spravania znamku horsiu ako 1.

V tlohe nema stcasne platit’, ze priemer je horsi ako 2,5 a spravanie je horsie ako 1. V tomto
pripade pre zaradenie Ziaka do vyberu staci, aby bola splnend jedna z podmienok.

Namiesto spojky and (a), pouzijeme spojku or (alebo). V pripade and je podmienka splnena,
ak st splnené obe (pri viacnasobnej - vSetky) jej Casti; v pripade or staci, aby bola splnena
jedina.

RieSenie potom vyzera:
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SET FILTER Expression: <expL>
ziaci.priemer>2.5 .or. =ziaci.spravanie>1

Vyberte ziakov, ktorych priemer je pod 1,2, alebo nemaju ani jedného surodenca.

Podmienky pre Character

Zvlastnost'ou su podmienky pouzivané pri poliach typu Character.

Vyberte zZiakov z prvej polovice abecedy (t.j. od A do K).

Pri tychto podmienkach si treba uvedomit, Zze rovnako ako ¢isla aj pismena maji v pocitaci
svoje poradie. Ak teda povieme, ze chceme vybrat’ Ziakov od 4 do K, znamend to, Ze nas
zaujimaju ti, ktorych meno je v abecede za A4 a pred K, t.j. meno>"A" .and. meno<’K”,
pripadne (ak berieme vratane A a K) - meno>="A4" .and. meno<="K"..

Podobne, ak by sme mali vybrat ziakov s menom zacinajicim na A, pouzili by sme
podmienku meno>="A4" .and. meno<”’B” atd’.

Zistite priemer Ziakov z druhej casti abecedy.
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OPAKOVANIE |

NajdolezitejsSim a najdrahS§im tovarom su informacie. Pocitate sa uz od svojho vzniku
zaoberali ich uchovévanim a spractivanim. NajbeZznejSimi a najCastejSie pouzivanymi
informédciami st rozne druhy evidencie (telefébnny zoznam, skladové karty, katalogy
v kniZniciach, zoznamy pracovnikov...).

Programy, ktoré sa zaoberaji uchovavanim a spractivanim informdcii, sa nazyvaju databazové
systémy. Pod spractivanim informécii treba rozumiet’ ich prezeranie, triedenie (vyber,
usporiadanie), tlac ...

Medzi najznédmejSie a najpouzivanejSie databdzové systémy patria v sucasnosti: dBase (s
nadstavbou Clipper), FoxPro, Paradox a Access pod Windows. Okrem nich existuje,
samozrejme, mnozstvo d’al§ich systémov, ktoré su dokonalejSie, no menej univerzalne.
Databazové systémy pracuju s udajmi ulozenymi v suboroch (databazach, databankach), ktoré
si mozno predstavit’ ako tabulky. V prvom riadku tabulky st nazvy stipcov, v d’alsich udaje,
ktoré im zodpovedaju.

Vsetky systémy maju rovnaky zaklad, u nés sa najcastejSie pouziva FoxPro.

Typy udajov
Dosial’ sme sa stretli len s
- alfanumerickym (character), ktory mdze obsahovat 'ubovol'né znaky a

- ¢iselnym (numeric, float) pre celé alebo desatinné Cisla.

Vytvorenie databdzy
- File> New- (.) Database,
- definujeme jej truktiru (ndzvy poli (stipcov), typy a rozmery),
- zaddme meno databazy.

Po tychto operaciach je hotova hlavicka (Struktura) a mdézeme sa rozhodnut, ¢i databazu
naplnime, alebo ju zatial’ ponechdme prazdnu.

ReZimy zobrazenia

- append (Record> Append) - sluzi na pridavanie tidajov do databazy; polozky vety su
zobrazené pod sebou.

- change (Record> Change) - vyzera rovnako ako append, no umoziuje len
prezeranie, nie pridavanie.

- browse (Database->Browse) - zobrazi databazu v prehl'adnej (tabulkovej) forme.
Prechod cez menu nemusi mat’ vzdy spravny uc¢inok (t.j. nie vzdy sa pri tomto postupe mozno
dopracovat’ k tabul’kovej forme, pretoze polozka Database-> Browse nesie zo sebou privlastok
browse last = zobraz podl'a posledného. Ak bola databaza pri poslednom otvoreni v rezime
append, bude v iom 1 teraz).

Medzi rezimami sa mozno prepinat’ (a to plati stopercentne) cez poslednu polozku v hlavnom
menu (podl'a vol'by bud’ Append alebo Browse).

Pohyb
Pohyb je pre zobrazenia browse a append trochu odliSny pri pouziti klavesov PgUp a

PgDown. Pri browse sa pomocou nich pohybujete po strankach, pri append vas PgUp posunie
o record vysSie a PgDown o record nizsie.

Zmena Struktury
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Database-> Setup->Modify - ponikne rovnaké okno ako pri definovani Struktiry a umozni
pridavat’, mazat’, menit’ poradie poloziek.

Viber stipcov
Database> Setup—>Set Fields - umozni vybrat stlpce, ktoré sa maju pri zobrazovani databazy

ukazat’. Ostatné sa nevymazu, zostanu len skryté.
Zobrazené stlpce st vysvietené jasne, skryté Sedivo.

Vyber riadkov
Database~> Setup-> Filter - umoziuje nastavit’ podmienku, podl'a ktorej sa budu do zobrazenia

vyberat’ vety - riadky.

Podmienka ma bezne tvar: pole, znamienko (ne-) rovnosti, hodnota.

Cisla piSeme beznym spdsobom, pre hodnoty typu character pouzivame ako oddelovade
uvodzovky.

V systéme mozno suc¢asne pouzit’ vyber stipcov aj vyber riadkov, no v podmienke je povolené
pouzit’ len zobrazené stlpce. (Kontrolou sa nemusite trapit, FoxPro vam nezobrazené stlpce
jednoducho neponukne.)

Viacndsobné podmienky

V pripade, Ze chceme, aby sa zobrazené riadky vyberali podla viacerych podmienok, musime
ich od seba oddelit’ logickymi spojkami and alebo or.

V pripade and sa riadok zobrazi, len ak st splnené vSetky podmienky stcasne, pri or staci
splnenie jedne;.

Logické spojky sa od ostatnych znakov oddel'uju bodkami.

Okrem nich existuje aj not, Co znamena opak (negaciu). Napr. pre podmienku vek je r6zny od
25, moZno pouzit’:

vek<>25

vek<25 .and. vek>25

.not.vek=25
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Okna

Vo FoxPro sa pracuje s oknami. Pre kazdu ¢innost, kazdu akciu sa otvoria prislusné okna.
Vicsinu z nich mozno presuvat’, usporadivat’ na obrazovke, prepinat’ sa medzi nimi ap.
Bezné okno (browse, command...) ma okrem svojho obsahu aj niekolko ovladacich prvkov
sluZiacich na manipulaciu s nim.

Command okno

Okrem menu sa po spusteni FoxPro nachiddza na obrazovke aj malé okno so zdhlavim
Command. Hovori sa mu Command okno (prikazové okno).

] Command
clear
SET FILTER TO tovar.cena
CREATE Untitled
SET FIELDS TO -
v

de >
Toto okno zaznamenava vSetky Cinnosti, ktoré ste od spustenia FoxPro vykonali, a okrem
iného umoziuje aj ovladanie systému pomocou prikazov.
Mozno ho v 'ubovolnej situacii vyvolat’ kombinaciou Ctrl+F2.
Boli sme zvyknuti napr. na otvorenie databazy pouzivat menu File->Open, vybrat subor a
odsuhlasit’.
V Command okne staci pouzit’ prikaz use meno_suboru a subor sa otvori.
Rovnako pre zobrazenie namiesto Record->Append stali append a databaza sa zobrazi.
Problémy so zobrazenim do tabul’ky a neustalym prepinanim sa vyrie$i prikaz browse, ktory
za kazdych okolnosti zobrazi tabulku.
Atd’.
Okrem takéhoto ul'ah¢enia st cez Command okno dostupné aj funkcie FoxPro, ku ktorym by
sme sa inym sposobom len t'azko dostali.
Napr. set status on zobrazi v dolnej Casti obrazovky stavovy riadok, ktory hovori o ndzve
databazy, pocte recordov (riadkov) a aktualnej pozicii. (K d’alsim potrebnym prikazom sa
dostaneme postupne.)

>l

| <C:>|ARCH |Rec: 12,17 [Ins  |Num

Vyhodou Command okna je aj moznost’ pohybovat’ sa po vykonanych prikazoch a 'ubovolny
z nich odklepnut’ (vykonat’ znova - netreba ho pisat’).

Typ Date

Vytvorte databdazu ZAMESTNANCI, v ktorej budete evidovat meno, datum narodenia, pocet
deti, plat, datum prijatia a stav (slobodny, zenaty, rozvedeny, vdovec).

V tlohe sa vyskytuju dve polozky, ktoré maju obsahovat’ datum. V databazovych systémoch
si nemusime lamat’ hlavu nad tym, ¢i pouzivat’ desatinné Cisla alebo vkladat’ datum do pol'a
typu Character. Vetky beZne pouzivané programy totiz obsahuju typ date. Obsahuje den,
mesiac a rok s tym, ze pri definovani Struktary si automaticky vyhradi 8 miest.
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Structure: Untitled

Name Type Width Dec

Field
MENO Character 16
DAT_NAR Date 8 <Insert>

<Delete>

« Q0K »

<Cancel>

Fields: 2 Length: 19 Available: 3981

Pri Standardnom nastaveni je datum v poradi mesiac/den/rok, t.j. v americkom formate. Ak ho
chceme zmenit’ na eurdpsky, u nas zauzivany (den.mesiac.rok), musime do Command okna
napisat’ prikaz set date german.

Datumovy typ je pomerne “inteligentny”. V pripade nespravneho datumu vés jednoducho
d’alej nepusti, pokial’ ho neopravite. Tym dokdze zabranit’ napr., aby sa zamestnanec narodil
33.11. alebo aby nastupil do prace 30.2..

Zobrazte zamestnancov, ktori sa narodili od roku 1968.

Co znamena narodit’ sa od roku 1968? Ze datum narodenia je po 31.12.1967. Do filtra teda
napiSeme:

zamestn.dat_nar>{31.12.1967}

Podobne ako tvodzovky pre typ character su zlozené zatvorky oddel'ovacom pre typ date.

Vyberte zamestnancov, ktori nastupili do prace v rozpdti rokov 1989 - 1992. Zobrazte len
meno a datum nastupu do prdce.

Typ Logical
Pridajte k udajom o zamestnancoch udaj o tom, ¢i maju okuliare a auto.

Tento problém by sme mohli vyriesit' tak, Ze by sme do Struktury pridali dve polia typu
character a do nich bud’ napisali slovom alebo "zakdédovali" do jedného pismena (A, N)
potrebné udaje. V databazovych systémoch je vSak jednou znajdolezitejSich poziadaviek
zabrat’ minimum miesta.

V pripade, ak ide o polozku, ktorej obsah mozno vyjadrit’ slovami 4no alebo nie, pouZziva sa
typ logical, ktory ma ti vyhodu, ze v pamiti (databaze) zabera len 1 bit (zatial'¢o kazdy znak
typu character zabera 1 byt = 8 bitov).

Structure: C:\FOXPROZB\ZAMESTN.DBF
Name Type Width Dec
Field
ks Character 28
ks Date 8 <Insert>
ks Numeric 2 a
ks Numeric 16 2 <Delete>
ks Date 8
ks Character 16
ks Logical 1
ks Logical 1 « 0K »
<Cancel>
Fields: 8 Length: 61 Available: 3939

(c) 1997 - 2006 www-am-skalka.sk

Skalka, Jan: Informatika III. (FoxPro)



19

Pre typ logical st pripustné len dve hodnoty: T (true = pravda = 4no) a F (false = nepravda =
nie). Pri definovani Struktary sa pre pole typu logical vyhradi automaticky jedno miesto.

Zobrazte zamestnancov, ktori maju auto, a vyberte len pole s ich menom a datumom ndstupu
do prace (samozrejme, aj s polom obsahujucim udaj o aute).

Podmienku vlastnictva auta zadame ako zamestn.auto =.T.. Ako oddel'ovac sa pre typ logical
pouzivaji bodky. Ak by sme chceli zamestnancov bez auta, ur¢ime podmienku zamestn.auto
=.F..

Triedenie (sortovanie)

Databazy su urcené na evidovanie tdajov. PoZzadujeme od nich, aby boli prehl'adné a aby sa v
nich rychlo dala najst’ hl'adana polozka. A preto je nevyhnutné mat’ v zozname aj urcity
systém. Najlogickej$im a najjednoduchs$im je usporiadanie databazy, napr. podla abecedy,
podla veku....

Na triedenie (usporiadanie) sa pouziva funkcia Sort (tried’). V menu sa nachddza Database >
Sort.

Datahase Fields: Sort Order:
MENO c 20 a < Move » > ¥
DAT_NAR D 8 a ¥
DETI N 2 5] < Remove > k3
PLAT N 18 2 ¥
DAT_PRIJAT D 8 B | Field Options ¥
STAV C 16 a (+) Ascending ks
OKULIARE L 1 a ( ) Descending ks
AUTO L 1 a [ 1 Ignore Case ks
¥
Databhase: Input Output
[ 1 Scope... < Save As... > [ 1 Fields... « 0K »
[ 1 While... < Cancel >

Pozostava z niekol’kych okien:
Database Fields - obsahuje zoznam vsetkych stipcov (poli), podla ktorych mozno triedit.
Field options - nastavenie vlastnosti triedenia:

- Ascending - triedenie vzostupne (od najmensieho po najvicsie),

- Descending - triedenie zostupne (od najvéacsieho po najmensie),

- Ignore case —ignorovat rozdiel medzi vel'kymi a malymi pismenami.

Abeceda v pocitaci je totiz organizovana trochu inak, nez ako sme zvyknuti ju pouzivat.
Najprv su znaky !, “, # $, .... potom cisla 0..9, nasleduju velké pismend A..Z, malé pismenad
a..z, znaky s diakritikou é, a, i... a napokon Specialne znaky (Ciara, dvojita ciara) atd.

V praxi to znamena asi tolko, zZe slovo Zenit bude podla abecedy skor ako babicka a oboje
predbehne slovo (Cislo) 251.

Ak zapneme volbu Ignore case, vyriesi sa aspon chaos medzi velkymi a malymi pismenami,
t.j. najprv bude babicka a az potom

Sposob triedenia (vzostupne, zostupne) treba nastavit predtym, ako presuniete pole
z Database Fields do Sort order.
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Datahase Fields: Sort Order:
MENO c 20 a < Move » > t 1 ZAMESTN.MENO
DAT_NAR D 8 a t 1 ZAMESTN.DAT_NAR
DETI N 2 5] < Remove > k3
PLAT N 18 2 ¥
DAT_PRIJAT D 8 B | Field Options ¥
STAV C 16 a ( ) Ascending ks
OKULIARE L 1 a (+) Descending ks
AUTO L 1 a [ 1 Ignore Case ks
¥
Databhase: Input Output
[ 1 Scope... < Save As... > [ 1 Fields... « 0K »
[ 1 While... < Cancel >

Sort order - hovori, podla ktorého stipca sa bude triedit. Ak napr. prenesieme do okna (napr.
dvakrat klik mySou) stipec meno, stibor sa usporiada podl'a abecedy (resp. abecedne podla
mena). Ak prenesieme datum nastupu do zamestnania, dostaneme subor usporiadany podl'a
asu, v akom zamestnanci do firmy prichadzali. Vratit' preneseny stipec do prvého okna
mozno opét’ kliknutim mySou.

Databazu mozno triedit’ nielen podl'a jedného stipca, ale aj podl'a viacerych. Predstavme si
stav, Ze mame v zozname okrem iné¢ho pitnast’ Jozkov Mrkvickov. Ako zaviest medzi nich
systém?

Mozno by bolo najlepSie usporiadanie podl'a veku. Vtedy do okna Sort order prenesieme ako
zakladné (master) pole meno a ako d’alSie dat nar.

Co to znamena?

V normalnej situdcii bude databaza usporiadana podl’a mena, no ked’ sa najdu dve (alebo viac)
presne rovnaké mena, pocitac ich ulozi podl'a veku.

MENO VEK
Kalerab Ivan 1.1.1956
Mrkvicka Jozko 12.8.1980
Mrkvicka Jozko 19.5.1976
Mrkvicka Jozko 3.8.1955
Mrkvicka Jozko 7.11.1948
Niktos Juraj 2.11.1975

Sorting (sortovanie, triedenie sortovanim) je triedenie databdzy do novej databazy, t.].
z povodného neusporiadaného suboru sa vytvori novy, v ktorom st uz recordy ulozené podla
zvolen¢ho kritéria.

Skupina Output sluzi prave na nastavenie niektorych vlastnosti nového stiboru.

Felds - rovnako ako pri zobrazovani databazy nastavuje polia. V tomto pripade ale ide o
polia, ktoré sa maji vlozit do novej - usporiadanej - databizy. Bez urcenia sa do novej
databazy skopiruju vietky stipce. Okno pre tito funkciu je rovnaké ako pri Database - Setup
-> Fields.

Save as - povedali sme, Ze sortovanie je triedenie databidzy do nového suboru. V tejto
polozke sa zaddva meno novej databazy.

Sort Destination File:

ML..1]
ARCH . DBF
FOXHELP .DBF
FOXUSER.DBF

1 4 ¢ > B

G.DBF Directory |FOXPROZB
KNIHY.DBF

TOVAR .DBF

ZIACI .DBF « Save »
[ 1 All Files < Cancel >

Do okna netreba vchadzat’, uplne postaci napisat’ meno nového suboru do riadku pod vol'bou.

(c) 1997 - 2006 www-am-skalka.sk Skalka, Jan: Informatika III. (FoxPro)



21

Output
< Save As... > [ 1 Fields...

utriedeny

Moznost' potvrdit’ triedenie (OK) sa aktivuje, az ked’ zvolite pole, podla ktorého sa ma
triedit, a nazov suboru, do ktorého sa bude usporiadanda databaza ukladat.

Ak zadate nazov ciel'ového suboru (ten, do ktorého sa bude vytvarat nové databaza) rovnaky,
ako je nazov prave pouzivaného, FoxPro vam taktne naznaci, Ze to nejde, lebo stubor sa uz
pouziva.

File is in use.

V pripade, ze zadate meno iného (nie otvoreného) uz existujuceho suboru, dostanete vystrahu
a otazku, ¢i existujuci subor prepisat’.

C:\FOXPROZB\KNIHY .DBF already exists,
overwrite it?

< Yes > <« No »

Pole, podla ktorého triedime sa casto nazyva aj kl’'ucove.

Usporiadajte databazu ZAMESTNANCI do suboru ZAM ABC podla mena.

Postup:
1. Databaza musi byt’, samozrejme, otvorena.

2. Database > Sort.

3. Vybrat’ pole, podla ktoré¢ho sa bude triedit, a preniest ho do pravého okna. (Dva razy
kliknat’ na meno).

4. Zadat meno nového suboru (do riadku v Casti Qutput).

5. Potvrdit’ OK.

6. !!! Otvorit’ novy subor - ZAM ABC.

7. Dat’ ho zobrazit’ (napr. browse do Command okna).

Usporiadajte databdazu ZAMESTNANCI do suboru DAT NAS zostupne podla datumu nastupu
do prace.

Najprv treba otvorit databdzu ZAMESTNANCI. V dialégu treba pred prenesenim pola
s datumom nastavit’ Field options na Descending. Potom urcit’ pole s ddtumom a d’alsi postup
je zrejmy.

Usporiadajte databazu ZAMESTNANCI do suboru ZAM AUTO podla abecedy, ale vyberte
do nej len polia s menom, platom a autom.

Usporiadajte databazu ZAMESTNANCI do suboru ZAM DETI podla poctu deti od najviac
po najmenej a vyberte do nej polia s menom, platom a poctom deti.
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Skupina Scope, For, While
Doposial’ sme taktne obchadzali skupinu Input.

Tato trojica sa vyskytuje takmer vo vsetkych d’alSich funkcidch FoxPro, ktorymi sa budeme
zaoberat’. Preto jej venujeme zvySenu pozornost’.

Input

[ 1 Scope...
[ 1 For...

[ 1 While...

For

For ma rovnaky vyznam (aj vyzor) ako Filter pri Database-> Setup. Nastavuje podmienku
pre vyber do novej databazy. T.j., ak chceme do novej databazy len zamestnancov, ktori maju
auto, napiseme do uz znameho okna prislusni podmienku a skopiruja sa len recordy, ktoré ju
spliiaju.

While

While je podobne ako For podmienka, no sluzi na zaddvanie podmienky typu: reb pokial’.
T.j., ak by sme do tejto podmienky uviedli zamestn.auto = .T., vykonaval by sa vyber
dovtedy, kym by sa nenasiel record spliiajici podmienku (zamestnanec s autom).

Ludsky: do novej databazy by sa vyberali recordy. Ak ma prvy zamestnanec auto, vyberie sa,
ak ma druhy - vyberie sa tiez. No ak sa stane, ze treti zamestnanec ma v tejto polozke F,
vyber sa skon¢i bez ohl'adu na zvysok tabulky.

Scope

Scope:

(+) All
<« 0K »
C ) Next
< Cancel >
( ) Record

C ) Rest

PoloZzka Scope vymedzuje oblast’ pouzitia. T.j. databazu alebo Cast’ databazy, s ktorou sa bude
pracovat’.

All - Standardné nastavenie. PouZziva sa v 99% vSetkych praktickych uloh. Znamena, ze vyber
alebo triedenie sa bude vykondvat v celej databaze.

Scope:

C ) All
<« 0K »
(+) Next 42
< Cancel >
( ) Record

C ) Rest

Next - operacia (triedenie alebo Cokol'vek iné) si vyberie Cast’ databazy od aktualneho recordu
(od toho, na ktorom je nastaveny kurzor) po record o zadané ¢islo d’alej (ak sme nastaveni na
24 recorde a zvolime Cislo 71, FoxPro bude pracovat’ s recordami 24 - 95) a zvySok databazy
akoby neexistoval.

Record - vykona operéciu s jedinym riadkom databazy (s tym, ktorého poradové ¢islo do
kolonky napiseme). S vyuzitim tejto funkcie sme sa doposial’ nestretli.
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Rest - vykona operaciu pre Cast’ databazy od aktuédlnej pozicie po koniec.

Usporiadajte databazu ZAMESTNANCI do suboru ZAM OKUL podla abecedy, ale vyberte
do nej len zamestnancov s okuliarami.

Usporiadajte databazu ZAMESTNANCI do suboru ZAM BEZ zostupne podla platu a vyberte
zamestnancov bez deti.

Usporiadajte databdazu ZAMESTNANCI do suboru ZAM B AU podla platu, vyberte
zamestnancov bez auta a polia s menom, autom, platom a poctom deti.

Usporiadajte databdazu ZAMESTNANCI do suboru ZAM POSL podla poctu deti, v pripade,
Ze pocet je rovnaky, nech sa usporiadaju podla abecedy. Vyberte zamestnancov s autom a
s okuliarami sucasne a polia s menom, autom, okuliarami, platom a poctom deti.

Matematické a Statistické operacie

Povedali sme si, ze databazové systémy sluzia na uchovavanie, ale hlavne na spracuvanie
informdcii. NajcastejSie pouzivanymi operaciami nad databdzami st matematické a Statistické
funkcie sluziace na vyhodnocovanie Ciselnych udajov v databaze. FoxPro poskytuje v menu
niektoré zakladné, iné st dostupné len pri programovani alebo cez Command okno.

Priemer

Pravidelne sa opakujicou ulohou v praxi je zistit priemer niektorej zhodndt ulozenych
v databaze. FoxPro ju riesi jednoducho: Database> Average.

Zistite priemerny plat zamestnancov z vasSej databazy.

Okno Average sa sklada z dvoch casti. Pre nas - ako neprogramatorov - je zaujimava len jeho
lavéa Cast’. Prava sluzi na urCenie premennej, do ktorej by sme mohli vypocitani hodnotu
vlozit'.

Average: Memory Variables:

[ 1 Expr...
[ 1 Scope... « 0K »
[ 1 For... < Cancel >

[ 1 While...

To Variable:

Scope, For a While uz pozname.
Polozka Expr (expresion) slizi na vyber stlpca, z ktorého chceme priemer vypocitat.
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| Math " | String " | Logical " | Date "
- <expN>
zamestn.plat
Field Names: Databhase: Variables:
L]
MENO C | ZAMESTN “ »_ALIGNMENT C a
DETI N _BOX L e
MPLAT N _INDENT N
VEK N < Verify > _LMARGIN N
DAT_PRIJAT D _PADVUANCE C
STAV C « 0K » _PAGENO N
OKUL IARE L _PBPAGE N
AUTO L < Cancel > _PCOLNO N
-

Vyzor otvoreného okna je rovnaky ako vyzor okna pre For, no nevkladdme don Ziadnu
podmienku, ale len nazov stlpca, pre ktory chceme zistit' priemer. V pripade, ze vlozime
nazov stlpca, ktory nie je ¢iselného typu, FoxPro nas na chybny krok upozorni.

| Math " | String " | Logical " | Date "
- <expN>
zamestn.meno
Field Names: Databhase: Variables:
L |
»MENO C | ZAMESTN “ »_ALIGNMENT C a
DETI N _BOX L o
PLAT N _INDENT N
VEK N < Verify > _LMARGIN N
DAT_PRIJAT D _PADVUANCE C
STA N
OKU N
AUT Numeric expression reguired N
— ]

Ak vsetky kroky vykondme spravne (Scope je nastavené Standardne na A/l, podmienky zatial
nepotrebujeme) a odstihlasime OK, FoxPro poda informaciu o priemere na pozadi - na
pracovnej ploche.

Pokial’ vysledok nevidite, odsuiite vsetky oknd dolava.

S records averaged.
ZAMESTN.PLAT
12712 .48

V pripade, Ze zabudnete, alebo zdmerne nenastavite Expr, ziskate priemery vSetkych
¢iselnych stlpcov v databaze. RieSenie je spravne v pripade nastavenia aj nenastavenia.
V prvom je vysledok prehl'adnejsi, v druhom ho ziskate rychlejsie.

S records averaged.

DETI PLAT VEK
2 12712.48 32

Priemer je pocitany na tolko desatinnych miest, kolko je vyhradenych pre prislusné pole
v databdze. V pripade, Ze nemate pole s desatinnymi miestami, vysledok sa zaokruhluje.

Vypocitajte priemerny plat zamestnancov s jednym dietatom.
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V tomto pripade potrebujeme okrem in¢ho nastavit’ aj podmienku For.
Pocita¢ pri kazdom vysledku vypiSe nielen priemer, ale aj pocet recordov, ktoré¢ do jeho
pocitania zahrnul.

Vypocitajte priemerny plat zamestnancov, ktori vlastnia auto.

Vypocitajte priemerny pocet deti zamestnancov, ktori viastnia auto.

Suma - sucet

Sum: Memory Variables:
[ 1 Expr...
[ 1 Scope... « 0K »
[ 1 For... < Cancel >
[ 1 While...

To Variable:

Tato operacia slizi na zistenie suétu hodnét v jednotlivych stipcoch. Dostaneme sa k nej
Database > Sum.
Vzhl'ad sumy, rovnako ako aj vSetky polozky, zodpoveda oknu Average.

Zistite pocet deti, ktoré maju zamestnanci dohromady.

V pripade, Ze sa nam nechce $pecifikovat’ stipec, ktory chceme sumarizovat’, jednoducho len
odklepneme OK a vo vypisanych vysledkoch ndjdeme sucet pre deti.

S records
MAX (ZAMESTN . PLAT)
23456 .88

Zistite kolko stoja firmu platy zamestnancov, ktori nemaju deti.

Zistite pocet deti zamestnancov, ktori maju auto.

Poéet recordov spinajtcich podmienku

Ak sa stane, Ze nepotrebujeme ani sucet, ani priemer, ale zaujima nas len pocet recordov
v databaze (alebo pocet recordov spliajiicich podmienku), pouzijeme Database > Count.

Count : Memory Variables:
[ 1 Scope...
<« 0K »
[ 1 For...
< Cancel >
[ 1 While...
To Variable:

Vzhlad je opét’ takmer zhodny s predchadzajiicimi funkciami, logicky chyba len Expr. Mozno
nastavit’ podmienky, oblast’ platnosti, alebo pre zistenie celkového poctu recordov v databaze
len odsuhlasit’.
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Vypisany vysledok hovori o prislusSnom pocte recordov.

S records

Zistite pocet zamestnancov, ktori boli zamestnani po roku 1992.

Zistite pocet zamestnancov starsich ako 45 rokov s menej ako dvoma detmi.

Calculate

Niekol’ko matematickych (alebo skor Statistickych) funkcii je obsiahnutych v polozke
Database > Calculate.
Tato polozka obsahuje vo svojej Casti Expr osem operacii:

[ AVUG (expN) Average of expN
CNTO) # of records

- <e| MAX(expN) Max value for expN
MINCexpN) Min value for expN
NPUC, ,) Net present value
STD (expN) Std. deviation of expN
——| SUM(expN) Sum of expN
F| VARC(expN) Variance of expN Variables:
»MENO c | ZAMESTN " »_ALIGNMENT C f
DETI N _BoX L e
PLAT N _INDENT N
VEK N < Verify > _LMARGIN N
DAT_PRIJAT D _PADUANCE c
STAV c « 0K » _PAGENO N
OKULIARE L _PBPAGE N
AUTO L < Cancel > _PCOLNO N :

AVG - to isté ako Average - vypoéita priemer z vybraného stipca.

CNT - to isté ako Count - zisti pocet recordov v databaze.

MAX - uzito¢na funkcia - najde maximéalnu hodnotu zo zvoleného stipca.

MIN - najde minimalnu hodnotu zo zvoleného stipca.

STD - zisti smerodajna odchylku.

SUM - to isté ako Sum - vypocita sucet vybraného stipca.

VAR - rozptyl hodndt od priemeru.

Funkcie m6zeme napisat’ aj ru¢ne, no najjednoduchsie je vybrat ich z ponuky Math.

Rovnakym sposobom mozno pouzivat prislusné funkcie aj pri zadavani podmienok, kde ich
Jje podstatne viac a pouzitelné su nielen matematicke, ale aj funkcie pre ostatné typy:

Pri pouziti Calculate nesmieme zabudnut’ zadat’ do zatvoriek meno stlpca, s ktorym operaciu
robime. V pripade, ze vyraz nevyhovuje jazyku FoxPro, operdcia sa nevykona a vypise sa
upozornenie.

| Math " | String " | Logical " | Date "

Variable 'EXPN’ not found.

Zistite maximalny plat vasich zamestnancov.
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S records
MAX (ZAMESTN . PLAT)
23456 .88

Typ Memo

Vytvorte databdazu VIDEOTEKA, do ktorej urobite evidenciu skladu videokaziet. Mala by
obsahovat: ndzov filmu, rezZiséra, hlavnu ulohu, producenta, diZku v minutach, cenu za kus,
rok vydania, typ filmu (akcny, dobrodruzny, horor, komédia, sci-fi, ...) a strucny obsah.

So vSetkymi polozkami okrem poslednej sme sa uz stretli, vieme pre ne vyhradit’ prisluSny
pocet znakov a polozky naplnit. Obsah je vSak polozka vel'mi variabilna a obcas si vyzaduje
aj vel’a slov. Vieme, Ze typ Character je obmedzeny na maximalne 254 znakov a l'ahko by sa
mohlo stat’, ze pre podrobnejsi obsah by nepostacoval.

Preto je pre obsahy (alebo vSeobecne pre poznamky alebo typy, ktoré by nemali byt
obmedzené - t.j., aby sme do nich mohli pisat’ kol’ko chceme) vyhradeny osobitny typ -
Memo.

Okrem moznosti naplnit’ ho l'ubovolnym mnoZstvom tdajov je charakteristicky tym, Ze
v paméti zaberie iba tol'’ko miesta, kol'ko tidajov don napiSeme. (Ostatné typy zaberaju tol'ko
miesta, kol’ko im vyhradime pri definovani Struktiry bez ohl'adu na to, ¢i ich naplnime, alebo
nechame prazdnymi.)

Pri definovani Struktiry sa pre Memo vyhradi len poznamka, Ze pdjde o neobmedzeny typ
(napriek klamlivému rozsahu 10).

Structure: Untitled

Name Type Width Dec
n Field
ks EZISER Character 38 A
1 L_ULOHA Character 38 <Insert>
ks RODUCENT Character 28
ks LZKA Numeric 3 a <Delete>
ks ENA Numeric 3 a
ks 0K Numeric 4 a
ks YP Character 15
ks BSAH Memo 18 . « 0K »
v
™ <Cancel>
Fields: 9 Length: 141 Available: 3859

V databaze (pri napifiani alebo prezerani) je v stipci s obsahom text memo (ak je polozka

prazdna) alebo Memo (ak uz obsahuje udaje).
[] VIDEOTEK
DlzkalCenaank |Tgp |0hsah|

128 238|1996
1868| 3881997

Ak sa chceme do polozky dostat’, bud’ na fiu klikneme mysSou, alebo sa nastavime kurzorom a
kombindciou Ctri+Home otvorime Memo okno.

komedia
sci—fi

memo
Memo

Ak chceme Memo okno opustit, stlacime Ctri+W alebo mySou klikneme do I'avého horného
rohu. V tomto pripade sa zmeny, ktoré sme urobili v obsahu polozky, vnest aj do databazy.
Ak chceme zrusit’ posledné zmeny (vratit’ sa k povodnému obsahu Memo polozky), stlaéime
ESC ana otazku, ¢i zabudnat’ na zmeny, odpovieme kladne.

Discard changes?

< Yes > <« No »
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Pri zmene Struktury databazy obsahujiucej Memo polozky treba postupovat nanajvys
opatrne. Ak sa ju budete snazit zmenit beznym sposobom, pravdepodobne pridete o vsetky
udaje v databaze. FoxPro vyhlasi chybu a pri snahe o prezeranie (browse) databazy sa zruti.

MEMO file is missingrsinvalid.
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OPAKOVANIE II

Okrem najzakladnejsich typov - Character a Numeric (pripadne Float) - pontika FoxPro
dalsie:

Date - typ, do ktorého sa ukladd datum. Je vybaveny kvapkou inteligencie. Nedovoli pisat
neexistujuce datumy. Je pren vyhradenych 8 miest.

Standardne ma FoxPro zapnuté americké zobrazovanie datumu: MM/DD/RR, no prikazom
set date german ho mozno prepnut’ na stredoeurdpsky format DD.MM.RR..

Pre rok sa vzékladnom nastaveni zobrazuju dve miesta a vloZzeny rok sa berie ako
1900+zadané dvojcislie. Ak chceme zobrazovat Uplny format, treba pouzit’ prikaz set century
on (zapni storocie).

Logical - najmenej miesta zaberajuci typ sluziaci pre udaje typu ano/nie, bud’/alebo.
Vyhradzuje si jediny bit a m6Ze nadobudat’ len dve hodnoty 7 (true = d4no) a F (false = nie).
Memo - neobmedzeny (poznamkovy) typ urceny pre rozsiahle polozky alebo pre polozky,
ktorych obsah vopred nie je znamy, pripadne je v kazdom recorde tplne iny (napr. poznamok
0 jednom zamestnancovi moze byt obrovské mnozstvo, zatial¢o o inom neevidujeme nic).
Vyznamnou vlastnostou tohoto typu je aj to, Ze nezaberd ziadne zbytoné miesto -
nevyhradzuje si ho ako iné typy.

Udaje ulozené v Memo polozkach sa neukladajii do stiboru s koncovkou dbf (kam ida bezné
udaje z databazy), ale pouzivaju stbor fpt. Preto, ked” budete prenasat’ databazy, nezabudnite
skopirovat’ aj tento.

Memo polozky su zobrazené v databaze ako memo (pre prazdnu) a Memo (pre plnu). Editovat’
mozno bud poklepnutim mySou alebo kombinaciou Ctri+Home. Zatvarame najCastejSie
Ctrl+Ww.

Oddelovace

Kazdy typ pre pracu so svojimi udajmi pouziva vlastné oddelovace, do ktorych ho
uzatvarame: Numeric, Float - nepouziva ziadne oddelovace; Character - ivodzovky; Date -
zloZené zatvorky - {}; Logical - bodky; Memo - uvodzovky rovnako ako Character.

Skupina Scope, For, While

Skupina je charakteristicka pre va¢sinu funkcii vo FoxPro.

Scope - nastavuje rozsah platnosti.

For - na spracovanie sa vyberaju len recordy spiiiajiice podmienku.

While - na spracovanie sa vyberaju recordy, kym je splnend podmienka.

Sortovanie

Database > Sort - triedenie (usporiadanie) do nového suboru podla zvolené¢ho kritéria. Do
stiboru mozno vyberat’ stipce aj recordy spinajiuce podmienku. Po vykonani operacie treba
novy subor otvorit’.

V pripade zmeny poradia (zostupne, vzostupne) treba nastavit’ najprv poradie a az potom
preniest’ stipec.

Matematické a Statistické operdcie

Priemer - Database > Average,

Sucet (suma) - Database - Sum,

Pocet - Database > Count,

Maximum, minimum ... - Database > Calculate.

Vysledky sa vypisuju na obrazovku - na pracovnu plochu - za otvorené okna. Pri Average a
Sum mozno nastavit’ vypocet pre jeden alebo pre vSetky stlpce (Expr).
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Command okno
Sluzi na ovladanie FoxPro prikazmi a zaznamenéava kazdu vykonanu akciu. Pomocou neho

mozno vyvolat’ funkcie nedostupné alebo len t'azko dostupné cez menu.

NajpouZivanejSie prikazy v prostredi

set status on/off - zapnutie/vypnutie stavového riadku,

set date german - prepnutie na eurdpsky format datumu,

browse - zobrazenie databazy do tabulky,

append - zobrazenie databazy pre pridavanie,

use - zatvori otvorent databazu alebo s menom otvori zadanu,

sum, average, count - zisti sicet, priemer (pre vietky ¢&iselné stipce) a pocet recordov v
databaze,

quit - ukonc¢i FoxPro.
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Tlacové zostavy - reporty

Vytvorte databazu SUSEDIA, v ktorej budete evidovat meno, vek a povolanie svojich susedov.

Evidovanie a spractivanie informacii je (napriek zdanlivej obsiahlosti) len ¢astou pracovnej
naplne spravcov databaz. Ovela viacsiu Cast’ energie venujil vytvdraniu vystupnych zostav
(foriem, akymi sa budu udaje tlacit’ na papier).

Nie je to tym, Ze by bola naro¢na na vedomosti, ¢as alebo zru¢nost. Problém je v tom, ze
informacie z databazy potrebuje kazdu chvil'u niekto iny. Najprv pride uctovnicka a chce
vystupy zamestnancov s platmi a odvodmi do fondov, potom sa ukaze personalny $éf a zela si
udaje o rodinadch zamestnancov, riaditel’ si zmysli kontrolovat’ im pracovné cesty atd’.

Pre kazdého “zékaznika” je potrebné vytvorit' osobitny vystup, vytladit’ ho (najcastejSie na
papier) tak, aby sa poskytovali len potrebné udaje a Setrilo sa papierom aj casom prislusnych
uradnikov. Treba dbat’ aj na formu, aj na Citatelnost’.

Databazové systémy viacSinou poskytuji aj jednoduchy néstroj na vytlaCenie databazy.
Vystup je vSak neprehl'adny, chaoticky a temer nikdy nezodpoveda poziadavkam zdkaznika.
Vyspelejsie (t.j. takmer vSetky) systémy ponukaji moznost’ vytvarat vystupné zostavy
aranzovanim poli, textov a r6znych prikra$leni. Tymto zostavam sa vo FoxPro hovori reporty.

Vytvorenie reportu

Ak chceme vytvorit’ novy report, zvolime File > New - (.) Report.
Ziskali sme okno rozdelené (viac-menej) na tri Casti:

PgHead - hlavicka strany,

Detail - obsah strany,

PgFoot - pita strany,
a polozku Report v menu.

System File Edit Databhase Record Program UWindow Report

] UNTITLED.FRX
R: B8 C: B8] Move || Page Header |
PgHead
PgHead
PgHead
PgHead
Detail
Detail
Detail
Detail
PgFoot
PgFoot
PgFoot
PgFoot

Najskor sa budeme zaoberat’ len Detailom. Je to Cast’ reportu, ktora sa na strane opakuje, kym
sa vmesti. Tato vetu lepsie pochopime, ked” vytvorime prvy report.

Postup:
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1. Mame otvorenu (nemusi byt zobrazena) databazu SUSEDIA a prazdne okno reportu.
2. Zvolime Report > Field.

Report Expression:

< Expr... >

< Format... > Width: a

[ 1 Style... [ 1 Suppress...

[ 1 Calculate... [ 1 Stretch Vertically

[ 1 Comment... [ 1 Float as Band Stretches
« 0K » < Cancel >

Tabul’ka obsahuje splet’ parametrov, ktorym sa zatial nebudeme podrobnejsie venovat, ale
hned’ prikro¢ime k:
3. Vyberu Expr a v ziskanej tabul’ke zvolime pole Meno.

| Math " | String " | Logical " | Date "

- Report <expr>:
susedia.meno

Field Names: Databhase: Variables:

»MENO C | SUSEDIA “ »_ALIGNMENT C f
VEK N _BOX L e

POVOLANIE C _INDENT N

< Verify > _LMARGIN N

_PADVUANCE C

« 0K » _PAGENO N

_PBPAGE N
< Cancel > _PCOLNO N :

4. Odsuhlasime OK pre Expr, odsuhlasime OK pre Report expression a v okne reportu

dostaneme mverzne VySV1etene pole.

] UNTITLED.FRX
R: 2 C: 26 || Move || Page Header ||
PgHead
PgHead
PgHead meno
PgHead
Detail
Detail
Detail
Detail
PgFoot
PgFoot
PgFoot
PgFoot

9]

. Uchopime ho mySou a presunieme do prvého riadku Detailu.
. Rovnako postupujeme pre polia Vek a Povolanie.
7. Uchopime Detail za posledny riadok a posunieme nahor.

*))

meno vek povolanie

8. Tymto je nas prvy report vytvoreny. Cez Report > Page preview sa pozrieme, ako vyzera.
System File Edit Datahase Record Program UWindow Report

] Preview
Jano Orech 33 kovac
Miso Maluch 41 =zlodej
Dezo Lajos 52 invalid
Anca Fernakova 41 predavacka
« Done » < More > Column: 5]
4o >

Ziskali sme obraz vystupu (podobne ako v T602 preview). Cast’ (riadky), ktora je rozlozena
v Detaile, sa opakuje, kym sa nezobrazi celd databaza (raz pre kazdy record). Ak sa nevmesti
na jednu stranu, rovnaky postup sa opakuje na d’alSe;j.
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Do detailu sme vkladali polia (fields), ¢im sme systému nariadili, aby na miesta, kde su
ulozené, vkladal ich obsah. Ak by sme vlozili (napisali) obycajny text, opakoval by sa
rovnako.

Zvdcsite Detail o riadok a napiste don svoje meno. Pozorujte, ako sa zmeni obraz strany.

Povedali sme, ze report sa skladé z troch Casti: hlavicky (PgHead), pity (PgFoot) a samotnej
strany (Detail). Hlavicka a pdta sa na kazdej vytlaCenej strane zobrazia len raz, obsah detailu
sa opakuje dovtedy, kym na strane nie je celd databdza alebo kym sa idaje vmestia na stranu.

hlavicka

detail pre 1. record
detail pre 2. record
detail pre 3. record
detail pre 4. record
detail pre 5. record
detail pre 6. record
detail pre 7. record

pdta

V reporte mozno pouzivat tri druhy objektov:

Bezny text (bude zobrazeny rovnako, ako ho napiSete) sa najjednoduchsie vklada priamo.
Kliknite na miesto, kam chcete vlozit’ text mysou, a potom len jednoducho piste.

Polia (fields) (nazvy poli, ktoré vidite pri vloZeni, sa nahradia obsahom prislusného pol’a) - do
reportu sa vkladaji cez menu Report - Field (v otvorenom okne zvolite Expr a pole, ktoré
chcete vlozit).

Ramceky (box) sluzia na zvyraznenie alebo estetické dotvorenie reportu a vkladaji sa cez
Report > Box.

Po vlozeni box blikd. Chce tym naznacit’, Ze mézete menit’ jeho vel'kost' (uchopenim mysou
za pravy dolny okraj a nat'ahovanim).

Objekty sa vidy vkladaju na miesto, kde je v reporte nastaveny kurzor.

Prvotné uloZenie objektov nie je, samozrejme, definitivne. Polohu (pripadne rozmery)
mdzeme menit. Pre presunutie sta¢i objekt uchopit’ mySou a “prelozit” na pozadované
miesto.

Ak chcete zmenit’ vel'kost’ boxu, stlacte Ctrl a kliknite naft mySou. Ramik za¢ne blikat’ a vy
mozete menit’ jeho rozmery.

Ak chcete objekt z reportu odstranit’, kliknite nan (vysvieti sa odliSnou - najcastejsie ¢ervenou
- farbou) a vymazte ho stlaCenim Delete.

Pre tpravu d’alSich vlastnosti postaci dvojité kliknutie na prislusny objekt. Rozbali sa okno,
v ktorom moézete nastavit’ dostupné vlastnosti.

Vzhl'ad reportu mézeme skontrolovat’ cez Report > Page preview.

RozSirenie o vlastnosti objektov

Vlastnosti textu

L1 Stgle... << 0K »
[ 1 Comment...
[ 1 Float as Band Stretches < Cancel >
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Style - sl0zi na nastavenie rezu pisma a centrovanie textu.

Style Alignment
[ 1 Bold () Left

[ 1 Italic C ) Center
[ 1 Underline C ) Right
[ 1 Superscript

[ 1 Subscript

<« 0K »

Code
[ | < Cancel >

Funk¢nost’ tohto okna je vSak obmedzena na niekol’ko druhov tladiarni. V pripade, ze chceme
nastavené vlastnosti pisma vyuZit, potrebujeme vicSinou nastavit’ ovladac¢ (Printer driver)
v menu File > Printer Setup.

Comment - sluzi na pisanie pozndmok o objekte (pri tlaci sa nezobrazuje, je len informaciou
pre inych uzivatel'ov reportu).

Float as Band Stretches - tla¢i do stipcov.

Ak chcete text editovat (upravovat), netreba (nemozno) nan kliknut. Najjednoduchsie je
nastavit’ sa don textovym kurzorom (nesmie byt cerveny) a pisat. Ak na text kliknete, zvolte
potom Report > Text (alebo stlacte ENTER).

Vlastnosti poli

Otvorené okno je rovnaké ako okno, ktoré sa pouZiva pri vkladani pola.

Report Expression:

< Expr... > susedia.meno

< Format... > Width: 28
[ 1 Style... [ 1 Suppress...

[ 1 Calculate... [ 1 Stretch Vertically

[ 1 Comment... [ 1 Float as Band Stretches

« 0K » < Cancel >

Expr - slazi na vyber pola.
Format - umoziuje nastavit’ format (typ) pola a niektoré jeho vlastnosti.

Napr. v pripade pol'a Numeric mozno nastavovat’:

Format: Editing Options:

Left Justify
Blank if Zero
(Negative)

Edit “SET" Date
British Date

CR if Positive
DB if Negative
Leading Zeros
Currency
Scientific

( ) Character (+) Numeric
( ) Date ( ) Logical

M
[0 S S Ry T [ T Ay S

« 0K » < Cancel >

Left justify - islo sa nezarovna napravo, ako je vo FoxPro zvykom, ale zostane nal’avo.

Blank in Zero - v pripade, Ze v Ciselnom poli sa vyskytne nula, nevypiSe sa, ale vynechd sa
namiesto nej prazdne miesto.

Leading Zeros - doplni prazdne miesta v databaze nulami.

r

Scientific - zobrazi ¢isla vo vedeckom formate atd’.

Dalsie vlastnosti pol'a:
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Width - nastavi vel'kost' (pocet znakov), ktoré bude z daného pol'a zobrazovat’ (ak pre pole
s vyhradenymi 30 znakmi nastavime width 10, zobrazi sa v beznom pripade len prvych 10
znakov). Tato vol'ba nastavuje len zobrazovanie. Nemeni Struktiru databazy.

Style - nastavuje rez pisma.

Calculate - mozno nastavit’ napr. tla¢ suctu recordov, ¢isla recordu... Nastavenim vlastnosti sa
straca povodny obsah pola.

Reset: | End of Report "

Calculate: Nothing
Count « 0K »
Sum
Average < Cancel >
Lowest

Highest

Std. Deviation

(
(
(
(
(
(
(
( Variance

)
)
)
)
)
)
)
)

Nothing - standardné nastavenie (ni¢ sa nedeje).

Count - namiesto obsahu pol’a vloZi na dané miesto ¢islo recordu v databaze.

Sum - vypise sucet numerickych hodnét recordov ulozenych v poli. Pouziva sa vac¢Sinou
v péte strany a uvadzaju sa doni sucty idajov na strane.

Average - podobny ako Sum, ale pocita priemer.

Lowest, Higest - ako predoslé; ndjde minimum a maximum.

Std. deviation, Variance - Statistické funkcie.

Comment - nezobrazovany komentar pre inych uzivatel'ov reportu.

Suppress — ne/zobrazovat’ rovnaké hodnoty.

Stretch Vertically — ddlezita voI'ba hovoriaca o zobrazovani do riadkov pod seba v pripade, Ze
sa obsah polozky nevojde do jedného. Najcastejsie sa pouziva pri tla¢i Memo poloziek, ktoré
takmer vzdy pozostavaju z viacerych riadkov. Ak je vypnutd, z obsahu uloZeného v Memo
polozke sa vytlaci len prvy riadok

Vlastnosti ramov

Toto okno prinasa len Styri nové vlastnosti pre vzhl'ad boxu:

Box:

«) Single line

(

C ) Double line « 0K »
( ) Panel

( ) Character... < Cancel >

[ 1 Comment...

Single line - obrysy boxu budu jednoduché (¢iara).

Double line - obrysy budu dvojité (dve Ciary vedla seba).

Panel - ¢iary v obryse budi nahradené plnymi znakmi - panelom. Vysledkom je plny obrys na
Sirku znaku.

Select a character:
[ A

B3 e
84 «
85 =
B6 ¢

87 .
——

« Select »

< Cancel >

SO U e W

<N ¢ >
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Character - ram mozete zlozit' z l'ubovolnych znakov. Po zvoleni tejto polozky dostanete
zoznam vSetkych dostupnych znakov, z ktorych mézete ram poskladat’.

Vicsinu znakov je schopnd zobrazit' len obrazovka. V pripade, Ze sa ich pokusite vytlacit,
moze sa stat, Ze namiesto srdiecok alebo siniecok nebudete mat nic¢ (tlaciaren nema znaky
definované a nahradi ich medzerami).

Vytvorte report z predchadzajucej databazy s tym, Ze pridate popis udajov:
Meno: Jano

Povolanie: penzista

Vek: 95

Meno: Duro

Povolanie: traktorista
Vek: 32 atd.

Tla€ reportu

Po vytvoreni sa report zvyCajne aj vytlaci (za tymto UcCelom sme ho vytvarali). Tla¢ sa
nastavuje a spusta cez Database - Report.

Report:

<Form... > [X]1 Environment [ 1 Scope...
C:\FOXPROZB\UNTITLED.FRX For...

[ 1 Quick Report... [ 1 While...
[X]1 Set Printer Driver

[l
—

Plain

No Eject
Summary
Heading

[l
e

<« 0K »
To Print
To File < Cancel >
Preview

Console On ( ) Console Off

~ e
.
e e

Sta¢i nam nastavit’ v poslednej skupine vystup na tlaciaren - To Print a potvrdit’ OK.
V pripade, Ze je vSetko v poriadku, ziskame vystup na papieri, inak FoxPro vyhlési chybu.

Printer not ready. Retry?

« Yes » < No >

NajcastejSou je vypnuté spojenie pocitaca s tlaCiariou (On line) alebo zapnuté prerusenie
(Pause), pripadne chybajuci papier. V kazdom pripade koliziu vyrieSime a zvolenim Yes
pokracujeme v tlaceni.

Ulozenie reportu
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Report uzavriete kliknutim na l'avy horny roh okna. Ak ho predtym neulozite (File > Save),
pocitac sa vas opyta, ¢i chcete vytvoreny report ulozit'.

Do you want to save changes to
C:\FOXPROZB\UNTITLED .FRX?

« Yes » < No > < Cancel >

Ak o tlacovy vystup nechcete prist, odsthlaste (Yes), napiSte meno stboru, v ktorom sa ma
report uchovat’, zvol'te Save a kladne odpovedzte na otazku, ¢i naozaj chcete udaje ulozit’.

Save Report As:
TN Drive
Directory |FOXPROZB
« Save »
[ 1 All Files < Cancel >

Vytvorte databazu DOMY a naplnte ju. Vytvorte report v tvare:
typ domu rozloha
poloha (adresa)

pocet izieb

a oramujte ho. Report vytlacte.

Otvorenie existujuceho reportu
Reporty sa nevytvaraju na jedno pouzitie, a preto sme obcCas nuteni otvorit’ uz existujuci.

Otvorenie reportu je takmer totozné s otvaranim databazy:
File > Open; po otvoreni okna vSak treba prestavit’ 7Type na Report.

Directory |FOXPROZB

<« Open »

Open:

ML..1]
ARCH . DBF
FOXHELP .DBF
FOXUSER.DBF
G.DBF
KNIHY.DBF

“ I ¢ > B

Datahase
Program

— ]

s
View
[ File jl Type < Cancel >
Index
Report
——| Label
Screen
Menu
Query

Ak neskor budete otvarat databdzu a nezobrazi sa vam, skontrolujte, ¢i nemdte typ
nastaveny na Report.

Vytvorte report pre databazu VIDEOTEKA v podobe kartotecnych listkov.
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Hromadna korespondencia

Vytvorte (otvorte) databdzu svojich znamych a navrhnite report, ktorym vsetkych pozvete na
oslavu svojich narodenin.

Toto je pripad, ked” mozete vyuzit' vSetky vyhody pocitaca. Napisete jeden list, namiesto
mena a adresy vlozZite prislusné polia a pre kazdého vytlacite.

Z estetickych dovodov by ste mali kazdi pozvanku vytlacit’ na osobitny papier.

V beznom pripade sa na jednu A4 zmesti niekol’ko pozvanok. Aby sme povolili na kazda
stranu len jednu, méme dve moznosti:

1. Natiahneme Detail na taku velkost’ (priddme mnoho prazdnych riadkov), Ze sa na stranu
vojde len raz. Je to spravne, ale neelegantné rieSenie a v inych pripadoch by nemuselo
vyhovovat’.

2. Zmen$ime pocitacovu stranu, t.j. nastavime stranu s men$im poctom riadkov. Pocita¢ po
vytlaceni posledného vydava tlaciarni povel na vysunutie papiera. Pocet riadkov na stranu sa
meni v Report > Page Layout.

Page Layout: < Options... >
Page length (rows): 66
Top margin (rows): a
Bottom margin (rows): a
<« 0K »
Printer indent (columns): 5]
Right margin column: 88 < Cancel >

Environment:

< Save > < Restore > < Clear >

[ 1 Printer Driver Setup...

Page length - pocet riadkov na stranu.

Top margin - pocet riadkov pre horné zahlavie.

Bottom margin - pocCet riadkov pre pitu.

Printer indent - Tavy okraj - poCet medzier, ktoré sa daji pred kazdy riadok = vzdialenost’
prvého znaku od l'avého okraja.

Right margin column - pravy okraj - pocet znakov na riadok. Nastavenych 80 je pre bezné
pismo na tlac¢iarni A4 pre papier po vyske.

V polozke Options mozno zapnut/vypnut’ vysuvanie (prazdneho) papiera pred a po vytlaceni
(Page eject before printing, Page eject after printing).

3. Po spravnom nastaveni dlzky strany a prevereni cez Page preview mdzeme pozvanky
vytlacit’.

Vytvorte databazu MENU a prislusny report s vyzorom menu v restauraciach.

Vytvorte databazu VYSVEDCENIA a prislusny report s menom, predmetmi, vymeskanymi
hodinami, miestom pre podpis a prislusnym oramovanim. (Pozn.: pravdepodobne budete
potrebovat zmenit dlZku strany.)

Pri praci s boxmi sa menej skusenym uZivatelom casto stava, Ze im zmizne objekt bez toho,
aby ho vymazali. Najcastejsim dovodom je jeho prekrytie inym objektom. Ak sa vam nieco
podobné stane, treba popresuvat objekty mysou a pohladat "stratenca” pod nimi.
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| MENO: meno I

| VEK: wvek I

| POVOLANIE: povolanie |

Neprijemnym problémom je aj nedorieSené zobrazovanie boxov (ak sa dva prekryvaju). Boxy
sa vSak napriek nekompaktnému (oddelenému) vzhl'adu na obrazovke vytlacia celistvo. Tento
nedostatok suvisi so zobrazovanim textovych znakov nielen vo FoxPro, ale aj v celom DOSe.

Ak sa stane, Ze na vystupe z tlaciarne su znaky (slova), ktoré na obrazovke (pri Page
preview) nevidiet, opdt bude chyba v ich prekryti inymi objektami.

Ak chcete presuvat’ viac objektov sucasne (napr. box s celym obsahom), vyberte mySou

oblast’, v ktorej lezia (vSetky sa vysvietia inou farbou) a uchopenim niektorého znich
posuiite.

PgHead
PgHead
Detail
Detail
Detail
Detail
Detail
Detail
Detail
PgFoot
PgFoot
PgFoot

MENO: meno I

VEK: wvek I

POVOLANIE: povolanie |

Vytvorte databazu DOTAZNIK, ktora bude obsahovat udaje o zamestnancoch: meno,
priezvisko, datum narodenia, stav, vzdelanie, pocet deti, plat, auto, zdravotny stav, poznamky,
predchadzajuce zamestnanie atd. Pre udaje vytvorte report, ktory bude rozdeleny na skupiny
podla oblasti, ktoru popisuje (osobné udaje, zdravotny stav, pracovné zaznamy...).

(c) 1997 - 2006 www-am-skalka.sk Skalka, Jan: Informatika III. (FoxPro)



40

OPAKOVANIE Il
Reporty su vystupné zostavy, podl'a ktorych sa robi vystup na tla¢iaren.

Vytvorenie
File > New = (.) Report

UloZenie
File > Save (Save as)

Otvorenie existujuceho reportu
File > Open a Type nastavit na Report.

Report sa sklada z troch Casti: hlavicka (PgHead), pita (PgFoot) a vnutro (Detail).
NajdolezitejSou castou je Detail, ktory sa opakuje na vystupe pre kazdy record databazy.

Druhy objektov

- text (klikneme mySou do reportu a piSeme),

- pole (field) - Report > Field - namiesto neho sa vklada obsah prislusného recordu,
- r4m (box) - ordmovanie a zvyraznenie textu.

Zmeny v reporte

- postiva sa uchopenim objektu a potiahnutim,

- vlastnosti sa menia dvojklikom na objekt,

- vel'kost’ (nielen boxov, ale aj poli) sa meni stlacenim Ctr/ a mySou,
- mazanie - po aktivovani (objekt s€ervenie) stlacenim Delete.

Sucasnd prdca s viacerymi objektami
- mySou ohranicit’ oblast’, v ktorej sa nachadzajui, a uchopenim jedného z nich presunut’ celu
skupinu.

ZvldStnost’ pre Memo
Pre polia typu Memo je rozumné nastavit’ Stretch vertically, ¢im zabezpecime tla¢ obsahu v
pripade, ak pozostava z viacerych riadkov.

Vyzor reportu
Report & Page Preview.

Tlac reportu
Database = Report a v poslednom zoskupeni nastavit’ vystup na To Print.

Dika strany
Report > Page Layout Page - Page Length

- pouziva sa najmd v pripadoch, ked’ na strane ma byt’ konkrétny pocet recordov z databazy.

Zdahlavie pre prvu a poslednu stranu
Nastavuje sa vo vol'be Report =2 Title/Summary a umoznuje definovat’ osobitné zahlavie pre
zaciatok a pre koniec reportu.
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Zakladné operacie, ktoré by mali poskytovat’ databazové systémy, pozostavaju okrem
spomenutych este z operdcii mazania, pridavania z inej databazy, kopirovania casti do inych
databaz, vypoctov na tirovni recordov a hl'adania.
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Mazanie recordov

Doteraz sme sa nestretli so situaciou, v ktorej by sme potrebovali z databazy vymazavat
Gidaje. V praxi sa viak bez tejto operéacie obist’ nemozno. Udaje, ktoré prestanti byt aktualne,
sa stavaju zbytonymi, spomaluju a komplikuju d’alSiu pracu s databdzou. V databazovych
systémoch je mazanie udajov pomerne zlozitou a na ¢as naro¢nou operaciou. (Nast'astie, len
na urovni programatorov, ktori systém vytvorili; pre uzivatela je rovnako jednoduché ako
napr. naplianie.)

Samotné mazanie pozostava z dvoch krokov:
1. logické vymazanie - oznacenie recordov urcenych na vymazanie,
2. fyzické vymazanie - skutocné - nendvratné odstranenie oznac¢enych recordov.

Takéto “dvojité” mazanie ma niekol’ko pricin.

NajdolezitejSie su, samozrejme, bezpecnostné. Pri skutone dolezitych informaciach si
operator nemdze dovolit omylom nenavratne vymazat daj. V tom lepSom pripade by ho
opdtovné obnovenie stdlo len drahy ¢as, v tom horSom... Ak sa stane, Ze sa nejaky record
omylom oznaci (vymaze logicky), ni¢ sa nedeje, odznaci sa a praca pokracuje, akoby sa ni¢
nestalo.

Druhym, nemenej podstatnym, dévodom je, ze pri rozsiahlych databdzach je mazanie na cas
vel'mi narocnou operaciou. Pokial’ poc¢as dita mazeme dvadsat’ raz, dvadsat’ rdz stratime Cas a
sme pri praci blokovani. Ale - ak dvadsat’ raz len logicky ozna¢ime nevyhovujuce recordy a
fyzické mazanie spustime ku koncu pracovnej doby (resp. na noc), vSetko je v poriadku.

Vo FoxPro mozno mazat’ nickol’kymi spdsobmi.

NajjednoduchSie je priame mazanie, ked’ sa v databdze nastavime na prislusny record a
kombinaciou Ctrl/+T (Toggle delete) record oznacime.

Oznaceny (logicky vymazany) record spoznate podla znacky na lavom okraji tabulky.
V tomto pripade sluzi rovnaka kombindacia (Ctr/+7) aj na odznacenie.

L] PSC =
Mesto Psc &
|
' Abelova 98513
' Abertamy 36235
' Abouce 98044
' Abraham 92545
' Abramova #3822
' Adamov 67904
" +Adolfovice 796081
" «Alber 37833
' Albrechtice (Karvind) 73543
" sAlbrechtice (Rych. n. Kn.) |51722
Albrechtice nad Vltavou 39816
filbrechtice v Jizer. horach|46843
Albrechticky 74255
+Alekiince 95122 ¥
o b

Ak chceme oznacit’ naraz viac recordov, pouzijeme vol'bu Record > Delete.

[ 1 Scope...
« Delete »
[ 1 For...
< Cancel >
[ 1 While...

V tomto okne mozno nastavit’ rozsah platnosti a podmienku, podl'a ktorej sa vyberu recordy.
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Vzhladom na to, Ze operdcia mazania patri medzi ‘“nebezpecné”, je rozsah platnosti
Standardne nastaveny len na jeden record. Ak chceme aplikovat podmienku na celu databdzu,
potrebujeme nastavit Scope na All.

Rusenie logického vymazania

Na odznacovanie recordov sa pouziva vol'ba Record - Recall.
Pre tato funkciu platia rovnaké pravidla ako pre Delete.

[ 1 Scope...
« Recall »
[ 1 For...
< Cancel >
[ 1 While...

Po vsSetkych oznacovaniach, upravach, odznacovaniach a kontroldch méze kone¢ne dojst
k fyzickému vymazaniu oznacenych recordov.

Tejto operécii sa hovori aj pakovanie databdzy, pretoze v podstate ide o nové rozlozZenie
recordov, ked’ sa na miesta vymazanych dostavaju tie, Co zostanu.

Databdza sa pakuje cez menu vol’bou Databaze - Pack alebo prikazom (cez Command okno)
pack.

Napokon dostanete eSte posledni moznost' na zrusSenie fyzickej likvidacie a po kladnej
odpovedi sa pakovanie vykona.

Pack C:\FOXPROZB\ARCH.DBF?

<« Yes » < No >

Otvorte databazu VIDEOTEKA a vymazte vSetky akcné filmy.

Otvorte databazu VYSVEDCENIE a vymazte vSetkych Ziakov, ktori mali z matematiky lepSiu
znamku ako 3.

Zavislosti

Spolu s funkciami Delete a Recall sa v jednej skupine menu nachadza aj Replace.
Tato polozka sluzi na nahradzovanie hodndt v stlpci, hromadné naplianie alebo pocitanie
hodnoty v zavislosti na inych stlpcoch.

Vytvorte databazu VELKOOBCHOD s polozkami nazov tovaru, cena za kus, dph, pocet
kusov, cena spolu. Naplnte len stlpce nazov, cena za kus a pocet kusov.

Predpokladajme, Ze DPH je pre vSetky druhy tovaru 23%. Potom pre kazdu polozku v DPH
plati, ze DPH = cena za kus * 0.23.

Keby sme databazu napliiali ruéne, potrebovali by sme pre kazdy tovar pocitat’ 0.23*cena za
kus a po jednom by sme napliiali databazu. Nastastie, existuje funkcia Replace, ktora vetko
urobi za nas.

Postup:

(c) 1997 - 2006 www-am-skalka.sk Skalka, Jan: Informatika III. (FoxPro)



44

1. Record - Replace
2. Nastavime sa v okne na pole, ktoré chceme nahradit’ - DPH.

Replace:
NAZOU C [ 1 Scope...
CENA_Zn_KS N
»DPH N L 1 For...
Kusou N
CENASPOLU N [ 1 While...
Databhase:
«Replace »
UELKOOBC
< Cancel >
< With... >

3. Vojdeme do okna With. Prostredie je ndm zname, ur¢ime zéavislost Cena za ks * 0.23 a
odsuhlasime.

| Math " | String " | Logical " | Date "
- WITH: <expN>
velkoohc.cena_za_ks=8.23
Field Names: Databhase: Variables:
L]
NAZOV C | UELKOOBC “ »_ALIGNMENT C a
»CENA_ZA_KS N _BOX L e
DPH N _INDENT N
Kusov N < Verify > _LMARGIN N
CENASPOLU N _PADVUANCE C
« 0K » _PAGENO N
_PBPAGE N
< Cancel > _PCOLNO N~
-

4. Rovnako ako Delete a Recall, aj Replace patri medzi funkcie so zvySenym
nebezpecenstvom straty udajov, preto je v oblasti platnosti nastavené Next.
Prestavime Scope na All.

Replace:
NAZOU C [X]1 Scope...
CENA_ZA_KS N
»DFH N [ 1 For...
Kusov N
CENASPOLU N [ 1 While...
Databhase:
«Replace »
UELKOOBC
< Cancel >
< With... > velkoobhc.cena_za_ks=B.23

Co to znamena?
Nastavenim v okne Replace na pole DPH sme povedali, Ze chceme nahradit’ stlpec DPH.

Udanim Cena_za ks*0.23 do polozky With (s) sme ur€ili, ze DPH nahradime 23% z hodnoty
tovaru.

A vyberom Scope > All sme prikazali urobit’ operéciu s celou databazou.

Po odstithlaseni OK sa v databéaze nahradi stipec prikazanymi hodnotami.
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Rovnakym sposobom urcte cenu spolu.
(cena spolu = cena_za_ks*kusov)

Pridajte polozku pre celkovi cenu aj s dph a naplte ju.
(cena_total=(cena_za_ks+dph)*kusov)

Z danej databazy vytvorte report a vytlacte ho ako ponuku pre maloobchody.

Vytvorte databdazu DAN PRIZNANIE s polozkami firma, obrat, vydavky, ktoré naplnite, a
s polozkami hruby zisk, zdravotné poistenie, fond zamestnanosti, socialny fond, danovy
zdklad, dan, cisty zisk so zavislostami:

- hruby zisk = obrat - vydavky

- zdravotné poistenie = hruby zisk * 0.135

- socialny fond = hruby zisk * 0.323

- fond zamestnanosti = hruby zisk * 0.06

- danovy zaklad = hruby zisk - fond zamestnanosti - socialny fond - zdravotné poistenie

- dan = (danovy zdklad - 21000)* 0.20

- cisty zisk = danovy zaklad - dan.

Vytvorte formular pre takéto danové priznanie.

Pomocou Replace mozete nielen pogitat’ zavislosti, ale aj naplhat’ stipce konkrétnymi
hodnotami.

V predchaddzajucej databdze nahrad'te polozku dan pausalnou sumou 20000.

Replace:

L |
ZDRAV_POI N a [X]1 Scope...
SOC_FOND N
ZAM_FOND N L 1 For...
DAN_ZAKLAD N
»DAN N o [ 1 While...
CISTY_ZISK N :

Databhase:

«Replace
DAN_PRIZ

< Cancel >

< With... > Zoo#e

Urtite ste si v§imli, Ze po tejto operécii sa zmenili len udaje v stipci dan a udaje v stipci sty
zisk zostali povodné. FoxPro si nedokaze zapamaitat’ vykonané operacie a pouzité zavislosti,
preto v takychto pripadoch musite povodné operacie zopakovat (mdzete pouzit Command
okno a odklepnut’ uz vykonané operacie).
Vypocitajte Cisty zisk pre zmenené udaje.

Rovnako ako pri inych operaciach mozno aj pri Replace pouzivat’ podmienku. V skuto¢nosti
percento pre zdanenie zavisi od hrubého zisku.

Vypocitajte dan podla platnych tabuliek, napr. pre danovy zaklad do

60000 -15%
120000 -20 %
180000 -25%
540000 -32%
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1080000 -40%
viac -42%
Pozn.: Uvedené udaje nemusia zodpovedat’ skutocnosti.

Takze okrem nahradenia hodnotou zaddme aj podmienky (napr. pre hruby
zisk<=100000.and.hruby zisk>75000 dame nahradit’ dani hodnotou hruby zisk*0.25).

Castou chybou je nesprdavne nastavenie kurzora v okne Replace. Ak sme nastaveni na poli
typu Character a chceme ho nahradzat numerickymi hodnotami, vyvolame chybu.

| Math " | String " | Logical " | Date "

- WITH: <expC>

dan_priz.dan_zaklad=B8.2
Field Names: Databhase: Variables:
FIRMA C f | DAN_PRIZ “ »_ALIGNMENT C f
OBRAT N o _BOX L e
UYDAVKY N _INDENT N
HRUBY_ZISK N < Verify > _LMARGIN N
ZDRAV_POI N _PADVUANCE C
SoC N
ZAM N

»DAN Expression must he of type C N

— ]

Vyhladavanie

Predstavte si telefonny zoznam s tisickami poloziek, v ktorom chcete najst osobu
nachddzajicu sa kdesi v strede databazy.

Mozete sa pohybovat’ rucne (Sipkami), no ovela hospodarnejsi a rychlejsi spdsob je pouzit
funkciu Record - Locate, ktord najde hl'adant polozku (resp. nastavi na fiu kurzor).

[ 1 Scope...

« Locate »
[ 1 For...

< Cancel >
[ 1 While...

Zadanim podmienky For v Locate sa kurzor nastavi na prvy record, ktory podmienku spiiia.
Zvolenim Record > Continue sa nastavite na d’al§i podmienku spliiajici record alebo (ak uz
ziaden nie je) na koniec databazy.

Po databaze sa mozno zrychlene pohybovat aj dalsim spdsobom - Record > Goto.

Top - kurzor skoci na zaciatok databazy.

Bottom - kurzor skoci na koniec databazy.

Record - kurzor skoc¢i na record s udanym poradovym ¢islom.
Skip - kurzor preskoc¢i zadany pocet recordov.

(+) Top
( ) Bottom « Goto »
( ) Record < Cancel >
¢ ) Skip

(c) 1997 - 2006 www-am-skalka.sk Skalka, Jan: Informatika III. (FoxPro)



47

Spajanie databaz

Ak sa udaje zbieraju od viacerych “objektov”, rieSenie problému si vyzaduje spojit’ vSetky
udaje do jednej databazy.

Na tento ucel sluzi vo FoxPro funkcia Database > Append from. Pridava do otvorenej
databdzy udaje zo zvolene;j.

Append From:

< From... > [ 1 Scope...
[ 1 For...
TYPE:l Datahase "
[ 1 While...
« 0K » < Cancel > [ 1 Fields...

Databazy spojite do jednej tak, ze vo From vyberiete databazu, ktorej obsah chcete pridat’ na
koniec otvorenej. Pridavana databaza zostane v povodnom tvare, len tidaje z nej sa skopiruja
do otvorene;.

Vyhodou funkcie je aj moznost’ pridavat’ nedatabazové subory ako databazu.

Napr. v T602 vytvorite tabulku, ktort chcete neskor spracovat’ ako databazu. Zvolite Append
from; v polozke Type spdsob, akym su v texte oddelené stipce, a odsuhlasite.

Append| Database
Delimited with Tabhs —
< Fro| Delimited with Commas
Delimited with Spaces
System Data Format (SDF)
TYPE:[ Symbolic Link Format (SYLK)
Data Interchange Format (DIF)
Microsoft Excel (2.8)(XLS)
« Microsoft Multiplan (4.81)(MOD)
Symphony (1.8) (WRK)
————| Symphony (1.1-1.2)(WR1)
Lotus 1-2-3 (1A)(WKS)
Lotus 1-2-3 (2.x)(WK1)
Lotus 1-2-3 (3.8)((WK3)
Paradox (3.5)(PDOX)
RapidFile (1.2)(RPD)
Framework II (FW2)

Database - klasicka databaza.

Delimited with Tabs - stipce st oddelené tabelatormi.

Delimited with Commas - stipce st oddelené &iarkami.

Delimited with Spaces - stipce st oddelené medzerami.

Ostatné typy - prislichaju inym databazovym systémom, z ktorych mdéZeme tdaje importovat
do FoxPro.

Pri spajani databdz mézeme urc¢it’ podmienku (For) aj polia (Fields), ktoré chceme pridavat.
V praxi sme sa stretli (dost' casto vo verzii 2.0) s pripadmi, Ze funkcia Append from

Jednoducho nefungovala. Z priddvanej databdzy si povyberala len niektoré stlpce, ostatné
nahradila prazdnymi napriek tomu, zZe polia boli rovnakych typov aj rozmerov.

Kopirovanie

Opacnou funkciou k Append from je Database > Copy to. Ako uz nazov napoveda, ide o
funkciu, ktora kopiruje tidaje z otvorenej databazy do ine;j.
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Copy To:
< Save As... > [ 1 Scope...
[ 1 For...
TYPE:l Datahase "
[ 1 While...
« 0K » < Cancel > [ 1 Fields...

Funguje na rovnakom principe ako Sort, no vysledkom nie je usporiadana databéza, ale
recordy v rovnakom poradi (niektoré mozno vynechat’), ako boli v pdvodnej databaze.

RozSirenim oproti Sort je moznost' exportovat Udaje do inych formatov (napr. do textu,
pripadne inych databazovych systémov). Typy st rovnaké ako Append from.

Total

Funkcia Database - Total je prostriedkom na s¢itanie numerickych poloziek recordov, ktoré
maju niektord hodnotu rovnak.
LCudsky: Mame niekol’korocnu databazu knih. Knihy nevozia naraz, prinasaju ich postupne.

TOTAL ON:

AUTOR
NAZOU
SUMA
UYDANIE
KUsS0oU

[ 1 Scope...

1 For...

ZZTZIOO
[l

[ 1 While...

[ 1 Fields...

<Expr... > NAZOU

<« 0K »
{3ave As...>

< Cancel >

Vzdy, ked privezi knihy, zaeviduje sa ndzov a zodpovedajici pocet kusov. Stane sa, Ze raz
privezl 50 knih s rovnakym titulom a o tyzden 23 takych istych. Knihy st potom evidované
v dvoch recordoch, aj ked” by uplne stacil jeden. VSetko je rovnaké nazov, autor, cena,
vydanie; datum neevidujeme. Casom sa v databaze nahromadi viac takychto poloZiek
(hovorime o redundancii).

Volba Total sluzi prave na rieSenie podobnych problémov. Vytvori novi databazu, v ktorej
bude ndzov knihy len raz a zodpovedat’ mu bude pocet vSetkych kusov s rovnakym nazvom.

Kliknutim do Total on vyberieme pole, podla ktorého sa bude sumarizovat’ (t.j. ndzov knihy).
Podmienkou tspeSného vyrieSenia je usporiadanie databazy podla polozky, pre ktoru sa
sumarizovanie vykonava. (Rovnaké knihy musia nasledovat’ za sebou, inak sa scitovanie
nevykona spravne.)

Najrozumnejsie je teda pred samotnou operaciou databazu utriedit’ alebo zindexovat (vid’
d’alej).

Mozno, samozrejme, nastavovat’ podmienky a oblast’ platnosti.

Neprijemné je, ze nemozno vybrat’ polozku, pre ktorti sa ma stucet urobit. FoxPro totiz scita
vSetky numerické polozky. Problém mozno obist’ len tak, Ze do vyslednej databazy vyberieme
pole s udajom (napr. nazov knihy) a pole s jeho hodnotou (napr. pocet knih z jednym
nazvom).

Vytvorte databdzu automobilov, v ktorej budete evidovat pocet kilometrov, ktoré najazdili.
Vygenerujte databazu, v ktorej bude informacia o tom, ktory typ kolko najazdil.
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Vytvorte databazu dodavok knih a z nej vygenerujte:
- databazu, v ktorej budu pocty knih pre rovnaké nazvy,
- databazu, v ktorej bude pocet knih privezenych v rovnaké dni.

Nezabudnite, ze databaza musi byt pred pouzitim Total utriedend.

Operacie s tabulkou

Zmena poradia stlpcov - sa vykona uchopenim za hlavicku tabulky (nazov stipca) a tahanim.
Novii Sirku stlpca - nastavite uchopenim za okraj (hranicu) stipca a tahanim.

Zdvojenie tabulky - dva pohlady na tabulku (v kazdom moZete mat’ zobrazeny iny stipec a
iny riadok, pripadne mdzete pracovat’ v inom rezime) - dosiahnete uchopenim a posunutim
dvojsipky v spodnej Casti okna s databazou.

] SUSEDIA =
Meno Uek |Povolanie F'y
Jano Orech 33 |kovac
Miso Maluch 41 |zlodej
Dezo Lajos SZ2]invalid
Anca Fernakova 41 |predavacka

-
v
o >.
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OPAKOVANIE IV

Mazanie

Mazanie recordov v databaze prebieha v dvoch fazach:

1. logické (oznacenie),

2. fyzické (pakovanie).

Deje sa tak z bezpecnostnych a ¢asovych dovodov, lebo mazanie je v rozsiahlych databazach
naro¢né na cas.

Mazat’ mozno po jednom recorde (Ctrl+T) alebo hromadne (Record - Delete). Rovnako
mozno logické mazanie aj zrusit: po jednom recorde - Ctr/+T, naraz - Record > Recall.
Na fyzické mazanie sluzi Database > Pack.

Zavislosti (hromadné napliianie)

Databazy mozno naplfiat’ ruéne alebo (ak existuja medzi stipcami matematické vztahy,
pripadne su v stipci rovnaké hodnoty) hromadne (Record - Replace).

V okne zadavame, ¢o (Replace), ¢im (With), za akych podmienok (For) a v akej oblasti
(Scope) nahradzat’.

Vyhladdvanie a presun

Na tieto operacie slizi Record > Locate, ked’ sa kurzor nastavi na prvy record spliajuci
podmienku; Record > Continue, ked’ skoc¢i na najblizsi d’alsi vyhovujuci nastaveniu a Record
> Goto, ked’ kurzor mozno nastavit’ na zaciatok, koniec alebo na poradovym c¢islom zvoleny
record.

Spdjanie databdz
Database > Append from
- kopiruje zvolent databazu (alebo textovy subor) na koniec otvorene;.

Kopirovanie databaz
Database > Copy to
- kopiruje aktudlnu databazu do inej (alebo textového suiboru).

Sumarizovanie
alebo scitovanie numerickych poloziek rovnakych recordov - Database > Total.
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Menu FoxPro

Zékladné funkcie FoxPro su zhrnuté v menu, ktoré¢ okrem mysSi mozno aktivovat’ stlaCenim
F10 alebo Alt.

Pre FoxPro je charakteristické, ze v ponuke su vzdy len tie funkcie, ktoré maju zmysel. (Menu
sa meni pri kazdej skupine akcii - napr. iné menu je pribeznom pouzivani; iné, ked
navrhujeme Struktiru, pripadne vytvarame report. Rovnako v pripade, ak nie je otvorena
ziadna databdza, nemozno aktivovat’ polozku Record.)

Podmenu System

Ahout FoxPro...
Help... F1
Macros. ..

Filer

Calculator
Calendar~Diary
Special Characters
ASCII Chart
Capture

Puzzle

Obsahuje zdkladné informacné a uZzivatel'ské polozky, bez ktorych by sme sa vo FoxPro
obisli, no svojou pritomnost'ou sprijemiuju a (aspon trochu) ul'ahcuju pracu.

About FoxPro - podava tdaje o programe a pocitaci.
Help - pomoc. Po stlaceni F/ alebo aktivovani cez menu sa otvori okno, ktoré obsahuje
zoznam hesiel, ktoré si k dispozicii. V pripade, ze stlacite F/ v niektorej z poloziek menu,

dostanete napovedu o prislusnom probléme (kontextovy help).
] Help =

Before You Begin
(c) Fox Holdings, Inc.
Using Help
Doc Changes Since Printing
What’s New Since 1.82
Technical Support
CompuServe —— The Fox Forum
FoxPro Self-Running Demo
Patching FoxPro

General Topics
Color Tabhle by Color Pair
Command Continuation
Commonly Asked Questions

vywvw YYYVYVYYYY

1 4 I ¢ > B

<« Help »

Macros - umoziuje definovat’ makré (podobne ako v T602).
Filer - spravca suborov. Ide o d’alSiu okliestenu kopiu Norton Commandera, v ktorej mozno
vykonavat’ zdkladné operacie so sibormi a adresarmi.

Filer

Name Ext Size Last Modified Attr

[..] 26—Jan-97 3:38p .... r Drv.
56883189 .TMP 655 16-Feh-97 1:22p .a.. ¢

58858368 .TMP B 16-Feb-97 1:58p .a.

58858372 .TMP 2848 16-Febh-97 1:58p .a. Dir.
58858679 .TMP 7688 16-Febh-97 1:58p .a.

58859191 .THMP B 16-Feb-97 1:58p .a.

58862226 .TMP B 16-Feb-97 1:58p .a. Files Like
74275179 .TMP 7?12 88-Feh-97 5:42p .a. *, %

ARCH .BAK 1655 16-Febh-97 1:36p .a.

ARCH .DBF 1167 16-Febh-97 1:37p .a. < Tag All >
ARCH .FPT 1216 16-Febh-97 1:37p .a. < Tag None >
DAN_PRIZ .DBF 576 16-Febh-97 1:47p .a. : < Invert >
< Find > < Copy > < Move > < Delete > < Sort >
< Edit > < Attr > < Rename > < Size > < Tree >
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Calculator - kalkulacka so zakladnymi operaciami.

Calendar/Diary - kalendar ponukajuci pohlad na aktuadlny mesiac s moznostou listovat’ o
mesiac (rok) dopredu i dozadu a nastavovat’ sa na aktualny datum. V pripade, Ze chcete
pouzit’ Diary a pisat’ si poznamky pre konkrétny den, tabeldtorom sa prepnete na didr a
Shift+Tab spat na kalendar.

Calendar~Diary =
Fehbhruary 1997
Su Mo Tu We Th Fr Sa

1

2| 3| 4| 5| 6| ?| 8

9|18 |11|12|13|14]15

16|17|18|19|28|21 |22

23|24|25|26|27 |28

KeM>ACM>»><Ce ¥ >LCY » > KToday>

ASCII chart - obsahuje vSetkych 255 zobrazitelnych znakov, ktoré su k dispozicii a
rovnakym sposobom ako zo Special Characters ich umoziiuje vybrat. Tabulka okrem toho
obsahuje aj ¢iselny kod znaku v desiatkovej a Sestnastkovej ststave.

Special Characters - Specidlne znaky. Vybrana ast’ zo vSetkych znakov, ktoré mozno vhodne
pouzivat’ najmi pri tvorbe reportov. Znak na poziciu kurzora dostanete dvojndsobnym
kliknutim mySou.

] Special Characters =
rTi1-— rem= FT1 mwn
FH4 1 ka0 F+4 4
LLa _ Loy - ELLd LA

tTl>r4dav)oetlt

%g.l-. B mr L

B e e e § 90 % =
CL ¥afhBNNE «» i -
aplFPrwmESocprdof does
En==x2<Jd+="° I B
AnAdadaatcéeeeiry
coodboUadiag
22 g G N

Capture - umoznuje kopirovanie cCasti obrazovky (pri praci s databazami prakticky
nevyuziteI'né).

Puzzle - logicka hra, ku ktorej sa moZno utiekat’, ked’ ste zifali zo vSetkého naokolo. Cielom
je poukladat’ zamieSané Stvorce od 1 do 15 za pomoci jedného prazdneho. Miesa sa Shuffle,
posutva sa kliknutim na Stvorec.

. Puzzle B Puzzle
6| 3|12 1| 2| 3| 4
5115 2] 9 5] 6|l 7| 8
18|14|13]| ? 9(18(11]12
1| 4| 8|11 13|14 |15
< Shuffle > < Shuffle >
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Podmenu File

New - vytvorenie nového suboru zvoleného typu: .Database - vytvori novu databazu. Tento
princip je vam uz dokonale znamy.

New. ..
Open...
Close

Save
Save as...
Revert

Printer Setup...
Print...

Quit

Program - otvori prazdne okno, do ktorého mozno pisat’ program v jazyku FoxPro. Ten
pozostava zo slov, ktorych ¢ast’ vam je uz tieZ znama (prikazy pisané do Command okna).

File - vytvori obyc¢ajny subor. Vysledok je rovnaky ako Shift +F4 v Norton Commanderi.

Index - vytvori sibor pre usporiadanie (budeme sa nim zaoberat’ d’alej).

Report - vytvori vystupnu zostavu.

Label - tieZ vytvori vystupni zostavu, ale navySe umozni ukladat’ udaje z recordov nielen pod
seba, ale aj vedla seba.

Datahase
Program
File
Index « 0K »
Report
Lahel < Cancel >
Screen
Menu
Query
Pro ject

Screen - vytvori uzivatel'skii obrazovku. Vyuzivaju ju najmd programatori, ktori navrhnu
vzhl'ad obrazovky a nechaju si vyrobit’ program, ktory ju nakresli.

Menu - podobny ako Screen. Programator si nakresli, rozlozi a definuje menu na obrazovke a
FoxPro mu nan vytvori program.

Query - sl0Z1 na spéjanie databaz a vytvaranie dotazov.

Project - sluzi (okrem iného) na vytvaranie exe suborov z programov FoxPro.

Open - otvori subor. Pri otvarani treba mysliet’ aj na spravny typ suboru.

Close - zatvori aktivne okno. V pripade, Ze chcete zavriet’ databazu, pouZzite prikaz use.

Save, Save as - sluzia na ulozenie suboru. Pri otvorenej databaze nie su aktivne, pretoze
databaza sa uklada priamo na disk. Vyuzivali sme ich najmé pri ukladani reportov.

Revert - sluzi na obnovenie suboru z disku. Pokial sme v nejakom stubore urobili zmeny,
neulozili ich na disk a chceme sa vratit k povodnému obsahu, zvolime tito funkciu.
Nefunguje pre databazy, ktoré sa na disk zapisujui priebezne a automaticky.

Printer Setup - nastavuje vlastnosti tlaCiarne.

Printer Setup:

< File... > « 0K »
< Cancel >

C ) Print On Left Margin: a

(+) Print Off Right Margin: 88

[ 1 Printer Driver Setup...

Umoznuje nastavit’ tla¢ nielen na tlaiaren, ale aj do suboru (vtedy sa text, ktory by normélne
iSiel na tlaciaren, uklada v rovnakom formate na disk - do suboru) po nastaveni Print fo na
File.
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Print on/off zapina alebo vypina komunikaciu s tlaciariiou.

Printer Driver Setup umoziuje nastavit' pre FoxPro inteligentni komunikaciu s nezndmou
tlaciarnou (Sikmé, tucné pismo...).

Print - vytlaci zvolené okno (Windows) alebo vybrany subor. Neslizi na tla¢ databaz
v tabul’kovej forme.

Quit - ukonci FoxPro.

Podmenu Edit

Podmenu slizi na pracu s textom a pouziva sa skor pri inych Cinnostiach ako pri praci
s databazami. V tomto poniati nie je pre nas zaujimavé.

Undo “u
Redo “R
Cut “X
Copy “c
Paste “v
Clear

Select All “A
Goto Line...

Find. .. “F
Find Again ~

Replace And Find Again
Replace All

Preferences...

Podmenu Database

Setup...
Browse

Append From...
Copy To...
Sort...
Total...

Average. ..
Count. ..
Sum. ..
Calculate...
Report...
Lahel...

Pack
Reindex

Setup - umoziuje zmeny v §truktire databazy (Modify), filtraciu - vyber recordov spliiajicich
podmienku (Filter), projekciu - vyber stipcov (Set Fields) a zobrazenie pola podla
formatového suboru (Format).

Browse - zobrazi databazu v rezime, v akom bola zobrazena naposledy.

Append from - pridava k otvorenej databaze idaje z inej databazy alebo in¢ho (textového)
stboru.

Copy to - kopiruje recordy (alebo Cast’ z nich) do inej databazy, pripadne z nej vytvara textovy
stbor.

Sort - vytvori novy stubor, v ktorom je databaza usporiadana podl'a zvolené¢ho pola.

Total - spocita numerické hodnoty pre rovnaké polozky. Databdza musi byt usporiadana.
Average - pocita priemer numerickych poloziek.

Count - zistuje pocet recordov v databaze.

Sum - vypocita sticet stipcov.

Calculate - obsahuje osem matematickych a Statistickych funkecii.
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Report - sluzi na tla¢ reportov. Pre vystup na tlaciaren méd byt v poslednej skupine
aktivizovana vol'ba To Print.
Label - sluzi na tla¢ labelov (menoviek, vizitiek).
Pack - pakuje databazu - stard sa o fyzické odstranenie logicky vymazanych recordov.
Reindex - reindexuje databazu (vid’ d’alej).

Podmenu Record

Append
Change

Goto. ..
Locate. ..
Continue “K
Seek. ..

Replace. ..
Delete. ..
Recall...

Append - zobrazi databazu v rezime append a umozni vkladat’ d’alSie udaje.

Change - funguje rovnako ako Append, ale umoziuje len upravovat’ (nie pridavat’) recordy.
Goto - nastavi kurzor na zaciatok, koniec alebo na pozadovany record zadany ¢islom.
Locate - nastavi kurzor na record spliiajuci zadani podmienku.

Continue - nastavi kurzor na najbliz§i d’alsi record spinajuci podmienku.

Seek - prehl'adava zindexovany stbor.

Replace - umoziuje napliiat’ zavislé stipce.

Delete - logicky maze (oznacuje) zvolené recordy.

Recall - rusi oznacenie logicky vymazanych recordov.

Podmenu Program

Do... “D

Cancel
Resume "M

Compile...
Generate. ..
FoxDoc

FoxGraph. ..

Slizi na spustanie a kontrolu spravnosti programu. Okrem iného umoziuje aj prekladat’
vytvorené obrazovky a menu do programovacieho jazyka. Nachadza sa mimo okruhu nasho
zaujmu.

Podmenu Window

Hide

Clear

Move “F?
Size “F8
Zoom t “F18
Zoom ! “F9
Cycle “F1
Color...

Command “F2
Debuy
Trace
View

Hide - skryje aktivne okno bez toho, aby sa zrusilo.
Clear - vymaze obsah aktivneho okna.

Move - umozni presun okna.

Size - dovoli menit’ rozmery okna.

Zoom A - zvicsi okno na celu obrazovku.

Zoom V¥ - zmensi okno na pdvodnu velkost.
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Cycle - preskoci na d’alSie otvorené okno.

Color - umozni zmenit’ farby prostredia FoxPro.

Command - aktivizuje Command okno.

Debug, Trace - urcené pre testovanie programov.

View - obsahuje nastavenia FoxPro a umoziiuje menit’ ich.

sk sk sk sk sk sk sk s sk sk s sk sk seoske sk sk sk sk s sk sk s sk sk sk sk sk seoske sk sk sk sk seosk sk seosk sk sk sk skoskoskeskoskok sk

Pod tymito vol'bami sa obas m6zu nachadzat’ d’alSie riadky, ktoré obsahuji zoznam vsetkych
otvorenych okien. V pripade, Ze zvolite niektoré¢ z nich, FoxPro vés doil prepne.

Podmenu Browse

Change

Grid Off

Unlink Partitions
Change Partition “H

Size Field
Move Field
Resize Partitions

Goto...
Seek. ..
Toggle Delete “T
Append Record “N

Podmenu sa aktivuje v pripade zobrazenia databazy.

Browse (Change) - prepne do jedného z dvoch reZimov zobrazenia databéazy.

Grid Off (Grid On) - vypne (zapne) zobrazenie Ciar, ktorymi s v rezime browse oddelen¢
stlpce.

Link/Unlink Partitions - su aktivne v pripade, ak tabul’ku databazy rozdelime na dve Casti, a
umoznuji pohybovat’ sa bud’ po oboch naraz, alebo len po jednej z nich.

Change Partition - v zdvojenej tabul'ke preskakuje medzi pohl'admi.

Size Field - zmeni §irku stipca.

Move Field - zmeni poradie stipcov.

Resize Partitions - zdvoji tabul’ku.

Goto = Record > Goto

Seek = Record > Seek

Toggle Delete = Ctrl+T (logicky zmaze, resp. odznaci aktualny record).

Append Record - prida prazdny record.

Podmenu Report

Page Layout...
Page Preview... "I

Data Grouping...
TitlesSummary. ..
Variahles...

Box B
Field... “F
Text “T
Add Line “N
Remove Line “0

Bring to Front “G
Send to Back “~J
Center

Group
Ungroup

Quick Report...

Page Layout - obsahuje vlastnosti strany (pocet riadkov, stipcov, zéhlavia, informacie o
vysuvani papiera - pred a po tlaceni - atd’.).
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Page Preview - ukaze obraz stranky.

Data Grouping - zoskupenie udajov podla spolo¢ného znaku (podobne ako Total).
Title/Summary - pridava osobitné “zahlavie” na zaciatok a na koniec celého reportu.
Variables - praca s premennymi.

Box - vlozi do reportu ram.

Field - vlozi do reportu pole.

Text - umozni upravovat’ aktivny text.

Add Line - vlozi riadok nad poziciu kurzora.

Remove Line - vymaze riadok, na ktorom je nastaveny kurzor.

Bring to Front, Send to Back - suvisi s polohou objektov, ktoré st na jednom mieste a
prekryvaju sa - Bring to Front prenesie do popredia, Send to Back presunie do pozadia.
Center - vycentruje objekt do stredu riadku.

Group - “zlepi” aktivne objekty a umozni pracovat’ s nimi (prestivat’) ako s jednym.
Ungroup - rozlepi objekty spojené Group.

Quick Report - vygeneruje report v "surovej" forme.

Podmenu Run

Je vymoZenost'ou verzie 2.5 a obsahuje najpouZivanejSie polozky dostupné aj z inych Casti
menu.
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Triedenie indexovanim

Ak sme doposial’ potrebovali utriedit’ stibor, pouzili sme funkciu Database - Sort, ktorou
sme vytvorili novy sibor obsahujuici recordy v predpisanom poradi.

Takéto triedenie ma tri nevyhody:

- pre rozsiahle databdzy moze trvat vel'mi dlho, pretoze tito funkcia jednak vyhladava
spravny record, jednak ho kopiruje do nového suboru,

- vytvara sa novy subor (Casto rovnako velky), o je opdt’ pre pracu s obrovskymi databdzami
vel'mi riskantné (Pahko sa moze stat, Ze pre novy subor nebude na disku dostatok miesta),

- vysledkom sortovania je databaza obsahujiica rovnaké recordy ako povodnd, len v inom
poradi - idaje st zbytocne zdvojené.

Z tychto dovodov sa v praxi sortovanie bezne nepouziva, nahradza ho indexovanie.

Pri indexovani sa nevytvara subor obsahujici udaje v inom poradi, vytvara sa len subor tzv.
ukazovatelov - indexov, ktoré (zjednoduSene) uruju poradie, v akom sa maju recordy
vypisovat’.

Napr.: nech su v databdze MENA uloZené recordy:
1. Roman
2. Andrej
3. Michal
4. Maria
5. Zuzana
6. FrantiSek

Pri sortovani ziskame novy subor s udajmi:
1. Andrej
2. Frantisek
3. Méria
4. Michal
5. Roman
6. Zuzana

Pri indexovani len “poradie”, v akom sa maju recordy vypisat’:
2.

N W e

Pri zobrazeni databazy sa udaje vypisuji v tomto poradi. Ak mdme porovnat oba druhy
triedenia vzhladom na miesto, ktoré zaberaji na disku, vyjde jednoznacne vitazne
indexovanie (¢im viac poloziek obsahuje record, tym viac sa uSetri). To isté¢ plati aj pre
rychlost’.
Okrem triedenia je mozné pri indexovani pouzivat aj podmienky. Ak by sme si dali vypisat’
zenské mend (podl'a abecedy), indexovy stbor by obsahoval polozky:

4.

5.
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Samotné vytvaranie indexovyxh suborov prebieha vo FoxPro trochu inak, ako bolo
popisané, no princip zostdava.

Vytvorenie indexu

Usporiadajte (indexovanim) databazu ZAMESTNANCI podla abecedy.

Ak chceme vytvorit’ index, pouzijeme File > New > (.) Index.
Ziskame okno, v ktorom nastavime jeho vlastnosti.

VTlavo je zoznam vsetkych poli, podl'a ktorych mozno indexovat’, vpravo su uz vytvorené
indexové subory (Ziadne). Ak chceme vytvorit’ index, zvolime pole, podla ktorého sa bude
vytvarat,, a prenesieme ho do pravého okna.

Datahase Fields: Index On:
Options
MENO C (+) Ascending
DETI N ( ) Descending
PLAT N [ 1 Unigue
VEK N <For...>
DAT_PRIJAT D Tag Name
STAV c
OKULIARE L
AUTO L < Move - >
<Remove~Edit >
- Index Expression 4 Output
<Expr...> C ) IDX [X]1 Compact
(+) CDX [X] Structural « 0K »
<Save As...>
C:\FOXPROZB\ZZAMESTN.C < Cancel >

Pri tejto akcii sa meno pola objavilo aj v polozke Tag name. Tato polozka udava meno, pod
akym bude index vytvoreny - volany (mozno ho menit, ale je to zbyto¢né).

V skupine Options sa nachadzaju d’alSie polozky:

Ascending, Descending - usporiadanie vzostupne alebo zostupne.

For - pre zadanie podmienky.

Unique - pokial’ je zapnuté tato vlastnost’ indexového stiboru, tak v pripade, Ze existuje viac
recordov s rovnakym obsahom polozky, podl'a ktorej sa indexuje, zobrazi sa len jedna (napr.:
ak mate v zozname Styroch Jozkov Mrkvickov, uréite indexovanie podla mena a zapnete
Unique, zobrazi sa len jeden z nich).

V okne Index Expression mozno nastavit’ vyraz, podla ktorého sa bude indexovat’ (s pouzitim
znakovych funkcii by sme mohli nastavit, aby sa neindexovalo podl'a abecedy, ale podla
druhého pismena alebo podla dlzky mena atd’.). Pre bezné potreby vystaime aj bez tejto
vol'by.

Okno Output hovori o sposobe, akym sa budu ukladat’ indexy na disk.
IDX - pre kazdy index vytvori novy subor,
CDJX - indexy patriace k jednej databaze sa ukladaji do jedného suboru.

Pre zadanu lohu staci presuntt’ pole s menom do pravého okna a odsuhlasit’. VSetko ostatné
sa vykona samo.

Pre databazu mozno mat’ vytvorenych aj viac indexov. Ten, podla ktorého je aktualne
usporiadana sa nazyva Master index. NajCastejSie sa indexy prepinaji v Database > Setup,
kde je Master index oznaCeny bodkou. Ak ho chceme prestavit, nastavime na nového
“mastera” kurzor a zvolime Set order.
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Database: C:\FOXPROZB\ZZAMESTN.DBF
Structure: <Modify> Indexes: Index
»MENO c 20 a 1ZZAMESTN : MENO
DETI N 2 a «12ZAMESTN : DAT_PRIJAT < Add... >
PLAT N 18 2
VEK N 2 a <Modify...>
DAT_PRIJAT D 8 a
STAV c 10 ] < Remove >
OKULIARE L 1 a
AUTO L 1 a <Set Order>
Fields: 8 Length: 55 Index expr:
Index filter:

[ 1 Set Fields...

C ) On (.) Off « 0K »
[ 1 Filter...
[ 1 Format...

Pri dalsom otvoreni databdzy sa spolu s fiou otvaraju aj indexové subory.

Pri vytvarani novych indexov je najrozumnejsie vSetky existujuce preniest z pravého okna
do lavého a zacat’ odznova. Zabranite tym castym zmdtkom.

Vytvorte index podla poctu deti a vyberte tych zamestnancov, ktori sa narodili po roku 1961.

Query

Query alebo po Cesky dotazy (slovensky ekvivalent tazko najst’) sluzi na vyber a spdjanie
databaz.

Majme niekol’ko databaz o svojich znamych. V jednej budu ich osobné tdaje, v druhej
pracovné, v tretej udaje o pribuznych atd’.

V kazdej databaze by mal byt identifikéator, podla ktorého ich spozname (evidencné Cislo
alebo jednoducho meno a priezvisko).

Pomocou Query dokazeme ztychto databaz vytvorit jednu. (Tento priklad je len na
pochopenie, praktické vyuZitie v iom zatial’ nehl'adajme.)

Vytvorte databazy OSOBNE a PRACOVNE, v ktorych budete evidovat' udaje o svojich

znamych.
OSOBNE PRACOVNE
Meno Meno
Adresa Zamestnavatel
Vek Plat

Tieto dve databazy spojime do jedne;.
Funkcia File > New - (.) Query nam poskytne okno, v ktorom mézeme databazy spojit’.
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] RQBE — UNTITLED
Datahases Output Fields Output To
»PRACOUNE ¥ MENO [X] Select Fields...
¥ ZAMESTNAVA
ks PLAT [ 1 Order By...
ks [ 1 Options...
ks [ 1 Group By...
< Add > 1 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example UpzLo Select
Criteria
<Insert>
<Remove>
< Or >
Postup:

1. Do okna Databases potrebujeme vlozit zoznam databaz, s ktorymi budeme pracovat.
Vol'bou Add databazu pridame, Clear ju zo zoznamu vymazeme.

2. Pri pridavani druhej databazy sa proces preru$i RQBE dialogom, v ktorom udavame
spojenie databaz (ktoré pole povazovat’ za spolo¢né).

RQBE Join Condition:

| OSOBNE . MENO " [ 1 NOT | Like " | PRACOUNE . MENO "

[ 1 Ignore Upper-Lower Case « 0K »

< Cancel >

V prvom okne st polozky prvej databazy - vyberieme meno. Druhé okno obsahuje “vztah”
(Like - ako (znamena, Ze jedno zo slov je ¢astou druhého), Exactly Like - presne ako (slova st
absolutne rovnaké), More Than - viac ako, Less Than - menej ako), podl'a ktorého sa spojenie
vytvori. My chceme vytvorit’ databazu, v ktorej spojime recordy s rovnakym menom, teda
ponechame nastavenie Like (pripadne prestavime na Exactly Like). V poslednom okne
vyberieme polozku meno z druhej databazy a odsuhlasime.(Vztah sa zobrazi aj v dolnej Casti
hlavného okna.)

Nastavili sme spojenie databdz podl'a mena , t. j. ak sa ndjde v oboch databazach rovnakeé
meno, vysledkom bude riadok ziskany spojenim tdajov z jednej aj druhej databazy.

3. Zostava nam este nastavit’ zobrazenie poli, ktoré maji byt v novej databaze - Select Fields.
Polia budu v novej databadze usporiadané v poradi, v akom ich zadame.

4. Zvolime Do Query a databdza je na svete.

QUERY =

Meno Adresa Uek | Zamestnava Plat A
Miso Zlatny Jaskynna 31 22 |Drevian, s.r.o. 4578.98
Jaroslav Kaciak |Rybnikovce 67 43 |Ryharsky =zvaz 12600.80
Jan Mafera Silovce 333 58 |0becny urad 3123.88

-

v

o4 >.

Spojenie sa vykonalo len do okna Browse (podla nastavenia v Qutput to). Ak chceme
vytvorit’ aj fyzicky subor, prestavime tato vol'bu na Table/ DBF.
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V tomto priklade sme spojenim databaz ziskali len spojenie databaz. Query sa ale vacSinou
pouzivaji najma kvoli Setreniu miestom. NajcastejSim pripadom je pouzitie v knizniciach.

V kniznici (alebo 'ubovol'nej inej pozi¢ovni) je potrebné evidovat najmé vypozicky.

Malo by sa vediet’ kto, kedy a Co si vypozical, t.j.: ¢islo citatel'ského preukazu, meno, adresa,
datum vypozicky, evidencné cislo knihy, nazov, autor, cena, vydanie, pocet stran, klucové
slova.

Databdza s takymto obsahom zaberie “dost™ miesta. A ak si jeden Citatel' vypozicia 10 knih,
alebo ak sa kniha vypozicia viac rdz (¢o je uplne normalne), udaje v databaze sa zacinaju
opakovat’ a jej objem katastroficky narasta.
A vtedy nastupuje moznost' rozdelit’ takuto obrovsku databdzu na niekolko menSich, v
ktorych sa idaje opakovat’ nebudu.
Systém by mohol pozostavat’ z troch databaz:
- Citatel (cislo citatel'ského preukazu, meno, adresa),
- kniha (evidencné cislo knihy, nazov, autor, cena, vydanie, pocet stran, klucove slova),
- vypozicky.
Vo vypozi¢kach by stailo evidovat' datum a jednoznacné identifikatory knihy a cCitatela
(cislo Ccitatelského preukazu, evidencné cislo knihy). V tomto pripade by nedochadzalo
k extrémnej redundancii a kompletné udaje o vypozicke by bolo mozné ziskat jednoduchym
pouzitim Query.
c¢islo ¢. p. datum vyp. ev. ¢. knihy
meno cislo ¢. p. nazov
adresa ev. C. knihy autor

cena

vydanie

stran

kluc. slova

Vytvorte databdzy a na zdklade ich prepojenia cez Cislo citatelského preukazu a evidencné
c¢islo knihy zobrazte kompletné udaje o vypozickach.

Vysledny dotaz mdze vyzerat’ takto:

] RQBE — UNTITLED
Datahases Output Fields Output To
UYPOZICK ¥ DATUM [X] Select Fields...
CITATEL ¥ MENO
PKNIHA ¥ ADRESA [ 1 Order By...
¥ AUTOR [ 1 Options...
ks NAZOU [ 1 Group By...
< Add > 1 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example UpzLo Select
Criteria
3] CITATEL.CCP L 1Like UYPOZICK.CCP L1
$] KNIHA . ECK L 1Like UYPOZICK.ECK [ 1] <Insert>
<Remove>
< Or >

Pri praci s Query mozZu nastat problémy s otvaranim suborov (pracuje vo viacerych
oblastiach). Ak sa vam prislusny subor odmieta otvorit, pouZite prikaz close all, cim zatvorite
vSetky databazy vo vSetkych oblastiach.
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Sucasné otvorenie (zobrazenie) viacerych databaz

Zvykli sme si, ze pri otvarani novej databazy sa stara vzdy automaticky zatvori a nech sme sa
¢o ako snazili, nepodarilo sa nam zobrazit’ naraz dve browse oknd pre dve rozli¢né databazy.
FoxPro tato operaciu cez menu ani nedokaze (ved naco je beznému uzivatel'ovi otvorenie
niekol’kych databaz naraz - aj tak mdze Citat’ v jednom okamihu len jednu).

V pripade, Ze potrebujeme napr. porovnavat obsahy dvoch databdz, mézeme pouzit’ Query
alebo postupovat’ nasledovne:

1. Zatvorme databazu prikazom use (len preistotu - nie je podmienkou),

2. Otvorime prvl databazu (a moZeme ju zobrazit),

3. Prikazom select 2 prepneme FoxPro do druhej pracovnej oblasti,

4. V novej pracovnej oblasti otvorime druhti databazu (a zobrazime ju),

5. Prepinanim sa medzi oknami mézeme sucasne pracovat’ s oboma tabul’kami.

System File Edit Databhase Record Program UWindow Browse

0SOBNE

Meno |ﬁdresa |Uek|
Miso Zlatny Jaskynna 31 22
Jaroslav Kaciak Rybnikovce 67 43
Jan Mafera Silovce 333 58
— —

] PRACOUNE = -
" Meno |2amestnaua |Plat a -
= -
® .Miso Zlatny Drevian, s.r.o. 4578.90 —
® Jaroslav Kaciak Rybarsky zvaz 12680 .80 e

mm=  Jan Mafera Obecny urad 3123.80 .
.
v
o4 >.

Prikaz select slizi na prepinanie medzi (Standardne) 25 oblastami, pri¢om v kazdej z nich
moze byt otvorena ind databaza (v dvoch oblastiach sa t4 ista otvorit’ nedd). Pre pracu s
konkrétnou databazou sa najprv musime do prislusnej oblasti prepntt’ (kliknutim na okno s
otvorenou databazou alebo pouzitim select).

Ak chceme databazy vo vsetkych oblastich zatvorit, pouzijeme prikaz close all, pre zavretie
databazy v aktivnej oblasti staci use.

Standardne (po spusteni FoxPro) je nastavend pracovna oblast’ 1.
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OPAKOVANIE V

Indexovanie

- triedenie pomocou indexového suboru. Oproti klasickému sorfovaniu je rychlejSie a zabera
menej miesta. Indexovy subor pozostdva z ukazovatelov, ktoré systému urcuju poradie,
v akom tdaje vypisat’.

Quel y

- slazi na spajanie databaz a vytvaranie “zostav” z viacerych suborov. Setri miesto a zvySuje
prehl'adnost’.

Sucasné otvorenie viacerych databdz

- mozno ho realizovat’ len vo viacerych oblastiach. FoxPro dava k dispozicii 25 oblasti, medzi
ktorymi sa prepina prikazom select. Standardne je nastavena oblast’ s Gislom 1.

Na uzavretie vSetkych otvorenych databaz (aj okien) sa pouziva prikaz close all.
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